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1. Obtenc¢ao de Dados

1.1 Modelo Digital de Elevacao SRTM30

Pode-se obter os arquivos do Modelo Digital de Elevacao (MDE, ou também no
inglés DEM, digital elevation model) da area em questdo nesse sitio. Esse MDE ¢
derivado da Shuttle Radar Topography Mission, SRTM, o qual tem resolug¢do horizontal

média de 30 metros.

Pode-se unir estes arquivos via ferramenta “Mosaico” do ArcGIS. Mais detalhes

neste sitio.

Deve-se sempre manter em mente que anualmente novos MDE s3o gerados, e
que para a area em que se estd trabalhando, pode haver um MDE de melhor resolugao.
Em sitio, por exemplo, podem-se visualizar alguns MDE de melhor resoluciao para o

Rio de Janeiro e Santa Catarina. Deve-se se manter atento a essas atualizagdes.

1.2 Inventario da Agéncia Nacional de Aguas

a) Nesse sitio, clica-se em “Softwares”.

Bem-vindo
Dados Hidrolégicos

Portal de Metadados Espacial - T |
: Hidro /¥

Sistema de Informagtes Hidrologicas

-
Janela de Trabalho: @ Unica @ Multipla.

Ep3agri AGUASPARANA o Furnas Eletronorte



http://earthexplorer.usgs.gov/
https://onedrive.live.com/view.aspx?cid=f3e4c2a1ea29981a&page=view&resid=F3E4C2A1EA29981A!222&parId=F3E4C2A1EA29981A!220&app=WordPdf
ftp://geoftp.ibge.gov.br/modelos_digitais_de_superficie/modelo_digital_de_elevacao_mde/
http://hidroweb.ana.gov.br/default.asp

b) Na nova janela aberta, no item “3. Inventario pluviométrico/fluviométrico
atualizado”, baixa-se o arquivo “Inventdrio.zip”, e anota-se a data da atualizagao.

Aqui, no caso, 13/04/2017.

7 HdroWet Bsizar Sofowares - Google Chrome

v
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3. Inventario pl etrico,
Descrigdo: Inventario atualizado em 13/04/2017
Baixar agora: & Inventario zip (130 MBytes) 4—
Para instalar: Faca o seguinte para instalar o Inventario no seu sistema

Aconselha-se também baixar o software “Hidro” no item “I. Hidro” para auxiliar
a visualizagdo e o acesso aos dados hidroldgicos do inventario. Em algumas etapas

deste presente tutorial, utiliza-se como base o layout do Hidro.

¢) O inventdrio encontra-se inicialmente compactado. Utiliza-se um programa
descompactador, como o Winzip ou Winrar, para extrair o inventdrio para uma
pasta. Ao extrair, notar-se-4 que o formato ¢ .mdb, o qual pode ser lido pelo
programa Access. Recomenda-se renomear o arquivo .mdb com a data de

atualizagdo do inventario, ja que este ¢ uma informacao chave e deve ser informada

no diagrama. Como importar os dados do arquivo .mdb para o programa de SIG

esta descrito no item de 2. Preparacdo de arquivos.

1.3 Inventario do SIGEL

Acessando este sitio, clica-se em “Download” para acessar o mapa de download

de dados.



http://sigel.aneel.gov.br/portal/home/

G’ ANEEL / Sistema de Informagées
/ Geogrificas do Setor
Acew trric L

Elétrico - SIGE

O Portal de Geoprocessamento da ANEEL retine os dados geograficos do Setor Elétrico que constam nas bases de dados da agéncia e tem
como objetivo dar publicidade a essas informagdes conforme preconizam os principios da administrag3o publica. Grgdos piblicos,
investidores, estudantes, consumidores e o péblico em geral ter&o fécil acesso as informag3es sobre as éreas de Gerago, Transmiss3o e
Distribuico de energia, podendo fazer uso desses dados para planejamento e monitoramento do setor, pesquisas académicas ou apenas

para conhecer o panorama do Setor Elétrico do pais.
Estdo disponiveis funcionalidades para visualizac3es, pesquisas e medicSes através dos Mapas Geograficos do Setor Elétrico e da
Catdlogo de Aplicasdes contendo o SIGEL, consulta aos Metadados, alm de aplicago web para realizagio do download dosdados nos

formatos shapefile e kmz (Google Earth)
Destaca-se ainda o Validador, aplicagdo web utilizada para verificado automatizada dos dados que serdo protocolados junto & agéncia
por agentes do setor, executando avaliagio dos arquivos shapefile e Memoriais Descritivos para os processos de Declaragéo de Utilidade

Publica (DUP).

Apos isso, clicar em shapefile (1), estender a janela aberta de shapefile para
facilitar a visualizagdo, selecionar as camadas desejadas para o download (2), descer a
barra de rolamento e clicar em “Executar”. Costumeiramente, estaremos interessados

nas seguintes camadas: CGH, UHE e PCH. H4 a Camada AHE que representa todas

juntas (Aproveitamentos Hidrelétricos).
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Assim, sera gerado um link para download na aba de saida com os arquivos

desejados em formato zip.

Extrai-se os arquivos, utilizando um descompactador (Winzip ou Winrar).
Aconselha-se aqui sejam salvos juntos na mesma pasta. Pode-se adicionar os arquivos

ao ArcGIS/QGIS, estando esses em formato .shp. Basta arrasta-los.

1.4 Hidrografia ANA, IBGE, e versoes regionais (HW, 2010)

Para auxiliar no desenvolvimento do Diagrama Unifilar, ¢ interessante obter os
tracados de drenagem da ANA. Estes arquivos podem ser baixados do GeoNetwork.
Nesse repositorio ha diversos arquivos. Um deles, de abrangéncia nacional, ¢ a Base
Hidrografica Ottocodificada Multiescalas 2013.

Ha também a hidrografia compilada do IBGE. Dentro da assim intitulada Base
Cartografica Continua do Brasil 1:250000 de 2015 (BC250, 2015), h4 dados de
hidrografia para a nagdo inteira. O sitio direto para a hidrografia para a BC250 de 2015
¢ este. Eventualmente o nome das pastas pode ser alterado pelo departamento de TI do
IBGE. Caso isso aconteca, o endere¢o ndo funcionard e sera necessario procurar na rede
FTP do IBGE.

Quando existente se faz também de bases hidrograficas regionais. No caso do Rio
Grande do Sul, ha a base hidrografica de Hasenack e Weber (2010) <https://www.ufrgs.
br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-

grande-do-sul-escala-1-50-000>. A hidrografia de Hasenack e Weber (2010) esta


http://metadados.ana.gov.br/geonetwork/srv/pt/main.home
ftp://geoftp.ibge.gov.br/cartas_e_mapas/bases_cartograficas_continuas/bc250/versao2015/Shapefile/Hidrografia_v2015.zip
ftp://geoftp.ibge.gov.br/
ftp://geoftp.ibge.gov.br/
https://www.ufrgs.br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-grande-do-sul-escala-1-50-000
https://www.ufrgs.br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-grande-do-sul-escala-1-50-000
https://www.ufrgs.br/labgeo/index.php/dados-espaciais/250-base-cartografica-vetorial-continua-do-rio-grande-do-sul-escala-1-50-000

disponivel em diferentes proje¢des. Para o Rio Grande do Sul, estando esse em zona de
latitudes intermediarias, recomenda-se utilizar a projecdo conforme de Lambert de dois

paralelos. Informagdes mais aprofundadas dessa projecdo podem ser obtidas neste ou

neste sitio.

1.5 Municipios IBGE

Dados georeferenciados de municipios podem ser obtidos em “bases e referencias
» bases cartograficas » malhas digitas”. O ultimo levantamento em formato shapefile
disponivel ¢ de 2015 e pode ser obtido neste sitio. Acessando “Municipal 2015, pode-

se procurar “br _municipio.zip”.

Caso o usuario necessite do endereco para download direto. Esse endereco pode,

porém, ja estar corrompido porque de tempo em tempo a estrutura de pastas do FTP do

IBGE ¢ alterada.

2. Preparacao dos arquivos

Escolhe-se entre duas opgdes neste tutorial para realizar os procedimentos de
preparagdo de arquivos: usar o ArcGIS ou o QGIS. Fica a critério do usuario qual dos

programas utilizar, sendo que ambos apresentam resultados semelhantes.

2.1. Utilizando o ArcGIS

2.1.1. Caminhos relativos no ArcGIS

Antes de comecar a trabalhar com o ArcGIS, recomenda-se habilitar a opgao de

armazenamento de nomes de caminhos relativos para fontes de dados.

Por padrdao o ArcGIS utiliza o caminho (ou endereco) completo para busca de
qualquer arquivo adicionado no mapa, porém pode-se alterar essa opcdo, tornando
relativo o caminho do arquivo mapa .mxd até os arquivos que estdo presentes no mapa
(e.g. dado um aquivo .shp localizado em C:\ArcGIS\projeto\subbacia8l.shp e um
arquivo do mapa do ArcGIS C:\ArcGIS\projeto\projeto_mapa sb81.mxd, o caminho
relativo passaria so pela propria pasta). Qual a vantagem? Caso se copie a pasta projeto

para um pendrive, pode-se abrir o arquivo .mxd e ele vai reconhecer que o caminho


https://docs.lib.noaa.gov/rescue/cgs_specpubs/QB275U35no47.pdf
https://pubs.usgs.gov/pp/1395/report.pdf
http://mapas.ibge.gov.br/bases-e-referenciais/bases-cartograficas/malhas-digitais.html
ftp://geoftp.ibge.gov.br/organizacao_do_territorio/malhas_territoriais/malhas_municipais/municipio_2015/Brasil/BR/br_municipios.zip

relativo até o arquivo .shp ¢ pela mesma pasta em que o .mxd estd; prontamente o

arquivo .shp serd encontrado.

Note ainda que a pasta “projeto” poderia ser realocada em qualquer local ja que os
arquivos todos estdo dentro de “projeto” e o caminho relativo entre .mxd e os arquivos
nao mudou. Diferentemente, quando nao marcada a op¢ao de caminhos relativos, se o
nome do disco local for alterado de “C:” para “G:”, aparecera o seguinte icone ao abrir

0 arquivo .mxd:

= [

Caso isso acontega sera necessario localizar de novo o caminho da camada, ¢ isso
sera um trabalho dispendioso e cansativo. Para evitar tais problemas, deve-se clicar na
aba “Arquivo”, em “Propriedades do Documento do Mapa...” e habilitar a caixa
“Armazenar nomes do caminho relativo para fontes de dados” como mostra as figuras

abaixo.

@ Untitled - ArcMap
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Para ndo precisar marcar essa op¢do toda vez que comegar um novo trabalho,
clica-se na aba “Personalizar”, em “Opgoes do ArcGIS...” e marcar a caixa “Tornar os
caminhos relativos o padrdo para novos documentos’ na aba “Geral”’, como mostra as

figuras abaixo.
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2.1.2. Importar Inventario ANA de formato .mdb para ArcGIS

a. Abre-se o arquivo Access e, dentro dele, a tabela “Estacao”.
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b. Na Barra de Ferramentas, clica-se “Dados Externos”. No espaco “Exportar”,

clica-se em “Excel” para exportar para planilha do Excel em formato .xIsx.
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c. Define-se nome, local e formato do arquivo de destino. Utiliza-se formato
“xIsx”. Novamente, recomenda-se manter a data de atualizacdo no titulo do arquivo.
Sugere-se, por exemplo, “2017-04-14-Inventario” uma vez que o formato “ano-més-
dia” facilita analise de um banco de dados grande. Isso ¢ particularmente importante

quando se pretende atualizar o diagrama rotineiramente.

Espedifique o nome e o formato do arquivo de destino.,

MNome do arquivo:  D:\Estacao.xlsx H D:\2017-04-14-Inventario.xlsx

Formato do arquive: | pasta de Trabalho do Excel (*.xdsx) lz‘

d. (Opcional) Preenche-se células em branco, e interpreta-se codigos ANA de

interesse.

Motivagao

Para que serve o Hidro na hora de visualizar os dados?
O Hidro interpreta os valores de cada coluna do arquivo .mdb
Pode-se montar uma simbologia, e utilizar rotulos (labels) no
programa de SIG, utilizando assim apenas um programa.
Basta que se entenda o significado de cada coluna da planilha
de Estacao do .mdb de Inventdario.

Abre-se o arquivo Excel recém-exportado do Access, e realiza-se algumas mudangas que
facilitardo a visualizacdo das informacdes de altitude, area de drenagem, e municipios. O
ArcMap interpreta células em branco como zero, o que pode eventualmente levar a equivocos
(e.g. uma estagdo pode exibir altitude zero, porém, na verdade, nunca se mediu a altitude dessa
estacdo). Também, encontra-se o campo de municipio sob um codigo apenas utilizado pela
ANA, e esse ndo ¢ interpretavel sem a presenca da relacdo “codigo da ANA - nome do

municipio”.

Para renomear todas as células em branco de altitude e area de drenagem para “-
99997, sugere-se no Excel seguir seguinte processo: seleciona-se primeiramente a
coluna com brancos a serem preenchidos, depois, na barra de ferramentas, clica-se em
“Classificar e Filtrar”, “Classificar do Menor para o Maior” (o Excel pode estar lendo
essa coluna como string e aparecera “Classificar de A para Z”. Nesse caso, seleciona-se

essa 0pgao).




Uma janela de aviso abrira. E extremamente importante que se marque “Expandir a

selecdo” antes que se clique em “Classificar”.

B =

0O Microsoft Excel localizou dades prdximos & sua selecdo. Como vocé ndo
seledionou esses dados, eles ndo serdo dassificados.

-
Aviso de classificagdo

0 que voc deseja fazer?

Continuar com a selecdo atual

Clica-se numa das células ndo nulas dessa coluna que agora foi classificada em ordem
crescente, segurar “Ctrl”, clicar “|”, soltar “Ctrl”, clicar “|” (1), digitar -9999 (2), e dar duplo
clique no pequeno quadrado preto no canto inferior direito dessa mesma célula (3). Isso copiara

todos os valores -9999 até a ultima célula em que ndo ha dados (4). Realiza-se esse processo

tanto para coluna de altitudes assim como para a de area de drenagem.
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Ainda se faz necessario adicionar uma nova coluna para o nome de municipio. Insere-se

uma nova coluna e a ela da-se o nome “MunicipioNome”.

&
W m | w | m | w W o
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o7 e 16 0 sEEmEsm L
CORREN 0 spmmpmmn 6
CORREN T ewmm— 6
RS pe— s
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Insere-se uma planilha nova (ou, pressiona-se Shifi+F11) na qual se coloca a relagdo

“codigo da ANA - nome do municipio”. A ela, da-se o0 nome de “Municipios”.
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Faz-se necessario seguir procedimento semelhante ao ja realizado, em que se exportou a
tabela de “Estacoes” do arquivo .mdb, no qual se encontra o inventario da ANA. Agora, porém,
deve-se exportar, também em formato .xIsx, a tabela “Municipio”, ao invés de “Estacoes”.

Sugere-se utilizar o nome “Municipio.xIsx”.

Uma vez exportada a tabela Municipio, deve-se abrir ela. Agora héd dois arquivos Excel
abertos. Copia-se as colunas Codigo ¢ Nome do arquivo “Municipio.xlsx” para a nova planilha

inserida no arquivo Excel do inventario de estagdes. Segue imagens abaixo:

°
°
°
°
°
°
0
°
°
°
°
°
°
0
° e o 13/08/2017
° vmsmee|  susmofooouemaL 13/08/ 2017
° e 13/04/2017
[ 1 13/08/2017
° s A 13/08/2017
o e 119 13/0472017
0 17fam 13/04/2017
° 1fin 13/08/2017
° v FABRICAND 13/08/2017
° 17} 3119500JCORONEL NURTA 13/04/2017
° 17} 2113608 CORONEL PACHECD 13/04/2017
o 13/08/2017
o ] 115507f0) 13/0472017
° 17} 13/04/2017
° e 13/08/2017
[} 172 13/08/2017
0 I B 13/0472017
0 e 13/04/2017
° e oTom 13/08/2017
° e 13/0a/2017
° s B i 13/04/2017
° e 13/08/2017
[ wfu 2 13/08/2017
o

wrjiramsonn]  s120sodfouves 13/0472017

17197000 CORONEL XAVIER CHAVES
17196000 CORREGO DANTA.
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Voltando-se a planilha “Estacao”, na primeira célula da coluna “MunicipioNome”

anteriormente criada, escreve-se a seguinte funcao:

“<[NDICE(Municipios!$A$2:$B$5706;CORRESP(J2;Municipios!$A$2:$A$5706;0);2)”

E da-se duplo clique no pequeno quadrado inferior direito da célula. Assim, acaba-se por
copiar essa funcdo para todas as células abaixo nessa mesma coluna. Espera-se que apareca o

nome de todos os municipios.

= —
A | oaw | ax ar 5] ) ] e [ o o [ o ] 0] B o [ B [ (3 [ (] 3 T () [ W Crl

e e e et ert ot e prtstarigaresett g i el preserpormet ' o rimag e e et g
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7 | pwwmnnn covenmrn AR 1 L) o ° ° 7 ° [} 0 mnnmnnn 1 TELEMETR QCORREN 0 me——" e|anGIcAL

[ 1 0 o 0 [ 7 0 [ | swasszas 1 ‘QCORREN 0 sesm——" 6| SERROLANDIA

= S S I I — —— —— — =

e — S — — T———— — T — e
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17| 1 L) L) [ ° 7 [ [} 0 sEEmEEES 1 QCORREN 0 sssseuen o TRES LAGOAS.

19 AR 1 0 o o o 7 o L] 0 FRRRRAEE 1 TELEMETR OCORREN 2 meeeny

E nnaanaas 1 L) o ° o r o [} 0 wwRRARAY 1 TELEMETR OCORREN 1 —

n 1 0 o o 0 7 o o p— 1 acoRREw 0 sessssen efsanpouinos

1 FRR 1 o o [] o 7 o (] L 1 AUTOMAT 22.11,200; 0 senss #|ouRcuAnDia

u 1 o o o o 7 o o 0 wrRmRARE 1 03/12/04) O M— ofsanpolAnoa

5 bl 1 0 o 3 o 7 o 3 | sssazaEE 1 TELEMETR OC, ORREM 0 sessssss GIPIRACURUCA

= B N I B S M~ R 7~ " bl

n 1 L) o ° o 7 [ [} o mmmmAE 1 OCORREN O m— ofsanta Luzia popari

E-] 1 o o 0 o 7 o o © sssazass 1 'QCORREN 1 ssssseny BfSANTA MARIA Db PaRS

35 1 L] o [ o 7 ] (] 0 mammases 1 OCORREN 0 ses— o mansa b SE0 FRancic

36 1 L] o ° ° 7 ° [} 0 mnmmmnen 1 QCORREN 0 s &|camPANARID

17| eenwRas 1 0 o o [ 7 o [ | uassaas 1 ‘QCORREN 0 me—— |CENTRAL DE M

) 1 L] o [ o 7 o ) 0 nanpasas 1 OCORREN 0 s— o mansa b SE0 Ffancic

a asssasas 1 L) o o [} 7 [ [] 1) wenassas 1 AUTOMATOCORREN 0 se— ofrEsmamas |7~

Pode haver eventualmente algum erro na fun¢cdo acima mencionada caso os dados nao
tenham sido copiados e colados exatamente como apontado, e.g. o nome da planilha inserida
(Shift+F11) ndo seja o sugerido (“Municipios”). Além disso, com o passar dos anos, a lista de
municipios da ANA pode apresentar mais ou menos municipios, € isso implicaria em uma
matriz relagdo coédigo-municipio de tamanho diferente. Enfim, ocorrendo algum erro, ou sendo

de interesse do usuario a logica da fun¢do acima mencionada, segue explicagdo abaixo:
“=INDICE(Municipios!$A$2:$B$5706;CORRESP(J2;Municipios! $A$2:$A$5706;0);2)”

“={NDICE(matriz relagdo codigo-nome;CORRESP(codigo de municipio da estacao que
sera procurado na matriz relacdo cddigo-nome;coluna de codigos da matriz relagdo codigo-
nome;o valor 0 indica que se deve buscar uma correspondéncia exatamente igual entre o codigo
de municipio da estagdo e o codigo presente na coluna de codigos da matriz relagcdo codigo-
nome*);o numero 2 indica que, apos ter sido encontrado o valor na matriz relacdo codigo-nome,
deve-se retornar o dado na segunda coluna dessa matriz)”

*As vezes se utiliza essa func¢do para buscar valores que sdo menores, ou maiores do que os que contam na

coluna. Esses artificios ndo sdo usados para resolug@o desse problema, no entanto.
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Pode-se realizar processo semelhante para adicionar uma coluna com o nome de rios, ja
que a priori s6 ha coluna de codigo de rios. Nesse caso, os parametros da fun¢ao INDICE serdo
diferentes, e deve-se adicionar uma planilha relagdo “codigo-nome” que se extrai também do

.mdb. No arquivo .mdb, o nome da planilha a ser exportada ¢ “Rio”.
Por fim, finalmente, salva-se o excel.

e. Posteriormente, faz-se interessante visualizar tais dados em programa de
Sistema de Informacgdes Geografico (SIG). Uma vez aberto o ArcMap, deve-se na Barra

de Ferramentas, clicar em “Arquivo” > “Adicionar Dados” > “Adicionar Dados XY...”

@) Untitled - ArcMap -
Arquivo | Editar Exibir Marcadores Inserir  Selecio  Geoprocessamento  Personalizar  Janelas  Ajuda
3 Novo.. Ctrl+N | 1:605.566.633 - SIEIE D $a . | Desenhando~ K
& A a0 1@ 7 Em Mg :
Saluay Lt tershed Processing = Attribute Tools » Metwork Tools ~ Apltilities = ':; & . =H
Sabvar Como...
Salvar uma Cdpia...
Compartilhar Como v
Adicionar Dados >| & Adicionar Dados...
HE Inscrever... B5  Adicionar Mapa Base...
EE  ArcGIS Onling... HH Adicionar Dados do ArcGIS Online...
Configurar Pagina e Impressora... +% Adicionar Dados XY... ‘
[Ef visualizar Impressio... Geocodificagio 3
& Imprimir... #;  Adicionar Eventos de Rota... Adicienar Dados XY
Exportar Mapa.. & Adicionar Camada de Consulta... Adiciona uma nova camada de
L | mapa bIEEIEEdD em eventos XY de

Seleciona-se no campo principal a aba do Excel, contendo as informagdes
desejadas. Uma caixa de didlogo seréd aberta e automaticamente os campos referentes a
latitude e longitude serdo preenchidos. Nota-se aqui que ao selecionar o arquivo Excel
sempre haverd uma op¢ao de pegar dados de uma planilha hipotética “Estacao”, ou de
uma mesma planilha “Esta¢@0$”. Selecionando a primeira, importa-se apenas valores,
ignorando formulas feitas na planilha Excel, ocasionando assim a eventual omissao de
dados calculados por fungdes. No caso da segunda, “Estacdo$”, é importado o valor de
saida de cada célula, levando-se em conta a equagdo. Sugere-se, entdo, sempre

selecionar a opgdo com cifrao, no caso: “Estacao$”.
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Uma tabela contendo coordenadas X e Y pode ser adicionada ao
mapa como uma camada

Escolha uma tabela do mapa ou procure por uma outra tabela:

Estacan$ ﬂ

Espedifique os campos para as coordenadas X, Ye Z:

Campa X: Longitude -
Campa Y: Latitude -
Campo Z: <Menhum:> -
Sistema de Coordenadas das Coordenadas de Entrada
Descricio:

Sistema de Coordenadas Geograficas:
Mame: GCS_SIRGAS_2000

[ Mostrar Detalhes

Avisar se a camada resultante tiver funcionalidade restringida

Sobre adicionar dados XY

.
Adicionar Dados XY [

O Sistema de Coordenadas deve ser definido como SIRGAS2000. Desde 25 de

fevereiro de 2015, segundo primeira resolucdo da presidéncia do IBGE/2015, o

SIRGAS2000 (Sistema de Referéncia Geocéntrico para as Américas) ¢ o Unico sistema

geodésico de referéncia oficialmente adotado no Brasil. O uso de outros sistemas pode

causar inconsisténcias e imprecisdes no momento de combinacao de dados. Esta medida

vem a facilitar o intercdmbio de informag¢des nacionais. Sendo assim, todos os arquivos

utilizados devem ser convertidos a SIRGAS2000, e arquivos criados devem ter sistema

de coordenadas definido como SIRGAS2000.

A mensagem abaixo avisa que ndo hd uma coluna com nome ObjectID. O ArcGIS

necessita dessa para habilitar agdes de selecdo, consulta, edicdo de fei¢des, ou definicao

de feigdes relativas. Clica-se “OK”. Posteriormente, quando se exporta essa mesma

camada em formato shapefile, o proprio processo cria essa coluna.

A Tabela ndo tem Campo CID

=)

definir feigBes relativas para elas.

dados exportados no mapa come uma nova camada.

A tabela que vocé especificou ndo tem um campo ObjectlD, desta forma, vocé
ndo podera selecionar, consultar ou editar as feigfies na camada resultante ou

Apas criar esta camada, vocé poderd exportd-la para um shapefile ou classe de
feigdo se vocé precisar destas fungBes. Para exportar uma camada, clique com o
botdo direito na Area de Controle e selecione Dados= Exportar Dadoes. Adicione os

0K ] [ Cancelar

Em seguida, clica-se com o botdo direito sobre a camada, “Data”, “Export

Data...”. Na janela que abrird, definir o endereco e o nome do arquivo a ser salvo.

Depois que o arquivo for salvo em shapefile uma janela perguntard se ¢ desejo adicionar
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o arquivo exportado ja no ArcGIS. Pode-se clicar que sim para visualizar e ja trabalhar

com 0 arquivo.

@ Untited - srckisp
Fle 2 View Scobmas Incet Selection Geoprocesng  Customae Windows  Help
Dees B x| o ke TR =111 L=l

RaMOI13+ x Dy

Lebel Festures
Edit Festures

% Corwert Festures to Graphics.

2.1.3. Selecao das estacoes de interesse

Com a bacia ja delimitada, pode-se entdo selecionar as estagdes da ANA, as
PCH, CGH e UHE que fardo parte do Diagrama Unifilar. Para isso, deve-se clicar em
“Selection >> Select by Attributes...”. Usa-se um comando para selecionar todos os

pontos de mesmo cddigo de sub-bacia. Aqui se selecionaram aquelas de codigo 86.

Select By Attributes PS

Layer: [ 207-03-10_Estacoes Bl
[ Onty show selectable layers in this list
Method: [Create a new selection ']

"Temporario" -

"Removida" M
"ImportadoR" b
"BaciaCodig”

"SubBaciaCo” -

E]-E

Selection | Geoprocessing Customize Windows Help Go To:
B Select By Atributes. |F GIE® O SELECT * FROM 207-03-10_Estacoss WHERE:
& et By Locaton. Select By Attributes L “SubBacialo” =86 1
dH  Zoom To Selected Fe. \Srjzcetss features by their attribute
é’ﬁ Pan To Selected Feat
¥ Statistics... . ..:. - e
[ Clear Selected Festures ., | [ Cear J[ ety |[ tHep ][ Load.. |[ Sare.. |
Interactive Selection Method — »
Selection Options... . [ Ok ] [ Soply ] I Goss ]

Em seguida, clica-se em “Selection >> Select by Location...”. Seleciona-se aqui

todos os pontos que fazem interseccdo com a camada da sub-bacia. Deve-se atentar para
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manter “add to the currently selected features in” e “intersect the source layer feature”

selecionados.

Select By Location |t S|

Select features from one or mare target layers based an their location in
relation to the features in the source layer.

Selection method:
[add to the currently selected features in -

Target layer(s):

207-03-10_Estacoes
[ 86_SRTM

[ Only show selectable layers in this list

Source layer:

[& 56 _srTm =l

Use selected features {0 features selected)

Spatial selection method for target layer feature(s):
intersect the source layer feature -
[] Apply a search distance

0,200000 Decimal Degrees

About select by location ok | [ apely | [ Close

Deve-se tomar cuidado ao realizar essa operacdo, pois hd casos em que as
coordenadas geograficas das estagcdes fornecidas pela ANA apresentam erros, como por
exemplo, estacdes da bacia de interesse localizadas fora da area do poligono e estagdes

de outras bacias dentro da area do poligono — situacdo ilustrada a seguir.

'Q Mepa_verficacan_estacoes.mud - Archiap
Arquivo Editar Exibir Marcadores Inseric Seleglo Geoprocessamento  Personalizar Janelas  Ajuda

INF=Y - FIENCT b - | 1100000 Rl =1 =1 Tl e Attribute Tools » Network Tooks - Aputilties~ 'S, & | 5z TR B~ Hep o
E— Bl j ez oy e »
S = it LY
Métods . [Gas uma nova seegtn -] ax Esan

]
Tomotes 3 i o o=
mportadol = o resss =
BaciaCodyg [ESTRADA DE BIRITIEA MIRIM o RIBEIRAQ GRANDE
“SubBaciaCo” e LSERTAOZINHO o
=

RoCad =

.ad BB 2]

e SOTIZ0  moraisy 25093
@ e @

=) (2] Com) & casan

2] [2=] (] : = odee | moTmie®
: .
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2.1.4. Estimar altitude de pontos de interesse via SRTM30 no ArcGIS

Do MDE pode-se extrair altitude estimada para as estagdes, os barramentos, e
qualquer outro ponto de interesse que esteja em formato shapefile. Nesta etapa serdo
utilizados os shapefiles com dados das estacoes da ANA, aqueles com os dados da

ANEEL e o modelo digital de elevagdo SRTM30.

1. Primeiramente deve-se verificar se a extensdo 3D Analyst esté ativa e, caso nao

estiver, deve-se ativa-la em “Personalizar” > “Extensoes...”:

Personalizar | Janelas  Ajuda

Barra de Ferramentas 3
‘ Extensdes...
Gerenciador de Complementos.. -
Extensbes
Medo Personalizar... X
Seleciona as extensdes do ArcGIS
Gerenciador de Estilos... Desktop que deseja utilizar. As

extensBes fornecem recursos
estendidos e normalmente exigem
que vocé tenha uma licenga para
utilizé-los, O dislogo lista as
extensies que estio atualmente
instaladas no sistema e quais
recursos do aplicative vocé esta
atualmente utilizando.

Opgtes do ArcMap...

2. Em “ArcToolbox" selecionar “Ferramentas do 3D Analyst” > “Superficie
Funcional” > “Adicionar Informagoes da Superficie”. Abrira assim a seguinte

caixa de didlogo:

'*\ Adicionar Infermagées da Superficie = | E % |
-
% Classe de Feigdo de Entrada )
I =
¥ Superficie de Saida
| =
# Propriedade de Saida
Selecionar Tudo ] [Desselecionar Tudo] Adidonar Valor
Método (opdonal)
LINEAR e
Disténdia de Amostragem (opcional)
Fator Z (opdonal)
1] =
[ 0K, ] [ Cancelar ] [ Ambientes... ] [ Exibir Ajuda == ]

3. Selecionar entdo como “Classe de Fei¢do de Entrada” um dos shapefiles com

dados aos quais deseja-se atribuir altitudes. Em “Superficie de Saida” deve-se selecionar
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o MDE SRTM30 e em “Propriedades de Saida” aparecerd a opgao , que deve ser

assinalada.

4. Deve-se repetir este procedimento até que os shapefiles da ANA e da ANEEL
apresentem as altitudes referentes ao MDE SRTM30. Isto pode ser verificado abrindo a
“Tabela de Atributos” de cada um deles. O procedimento acima acrescentard uma

coluna “Z” ao final da tabela.

2.1.5. Processamento de MDE para analise espacial no ArcGIS

Com o MDE do SRTM30 ja mosaicado e pronto para ser utilizado, ativa-se a
extensdao SpatialAnalyst para que se comece a utilizar as ferramentas do ArcHydro.
Deve-se definir o sistema de coordenadas das camadas utilizadas sempre como Datum

SIRGAS2000.

Para a montagem do Diagrama Unifilar, faz-se necessario um raster de
acumulagdo de fluxo. Portanto, no mosaico deve conter a area de todas bacias que se
propdem estudar (principalmente bacias a montante, mesmo que elas ndo sejam objetos
de estudo; bacias a montante influenciam as areas de drenagem de estagdes e usinas
presentes no curso de rios principal de bacias a jusante). Pode-se observar esse fato no

mapa que segue.

Localizaglo das Sub-Bacias [
na Bacia do Rio »

. 9
| Bacia do Rio Uniguai
| ] masss Agua
=3 timites Poliicos

r #  Capital Federal

®  Municipios de sc ‘com mais de 20.000 habitantes
| ® Municipios do RS com mais de 20,000 habitantes.

[Fontes: Marcuzzo etal, (2016) - Bacia e Rio Uruguai,
ANA (2014) - Corpos D'Agua
ERiEiglnF 1502 G014’ SRTM ol
Natural Earth
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Qualquer elemento que esteja no rio principal na sub bacia 73 sofrera influéncia
das areas de drenagem das bacias 72, 71 e 70. Por essa razao, reitera-se a importancia

em utilizar o arquivo do MDE mosaicado por inteiro.

Apresenta-se aqui o seguinte indice dos passos que hao ser realizados no

ArcHydro para determinar a area de drenagem da bacia em estudo:

—

FillSinks

Flow Direction

Flow Accumulation

Stream Definition

Stream Segmentation
Catchment Grid Delineation
Catchment Polygon Processing

Drainage Line Processing

A AN

Adjoint Catchment Processing
10. Drainage Point Processing

11. Batch Point Generation

12. Watershed Delineation

Antes de tudo, para comecar a utilizar o ArcHydro, deve-se definir o destino dos
arquivos que serdo gerados e utilizados nos processos. Para isso, clica-se em

“ApUtilities” > “Set Target Locations”. Clica-se duas vezes em “HydroConfig”.

Define-se para os documentos raster uma pasta, de preferéncia vazia, em que os
raster serdo armazenados. Para salvar os vetores, deve-se criar um Arquivo
Geodatabase e defini-lo como destino. Recomenda-se que o Arquivo Geodatabase seja
criado dentro da pasta definida como destino para os arquivos raster. Este procedimento

ajuda a evitar erros.

-
@ Set target locations for HydroCanfig Ié]

_ Application @ Maplevel MapName: |layers vI

RasterData: “\Users' Usuario“ Desktop "CPRM\Bacia 7 Arc Hydro'

a

VectorData: ¢\ sers' Usuario'\ Desktop \CPRM\Bacia 7\ Arc Hydro Arc Hydro adb =

OK |[ Help |[ Cance
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1. Antes de utilizar o MDE como base para a determinagdao da bacia, deve-se

corrigir suas possiveis “falhas”.

Quando uma célula esta circundada por células de maior elevagdo, os algoritmos
utilizados no ArcHydro interpretariam que 4gua drenada até ali ficaria presa nesta
célula e isso ¢ chamado de “buraco”, ou “depressdo”, no Modelo Digital de Elevagao.

Deve-se, portanto, preencher essas depressoes.

Para evitar esse impasse, segue-se “ArcHydro Tools” > “Terrain Preprocessing”
> “DEM Manipulation” > “FillSinks”. Informa-se o arquivo do MDE (ou, em inglés,
Digital Elevation Model, DEM) e o ArcHydro criara um arquivo chamado “Fi/”.

Recomenda-se que o arquivo do MDE utilizado seja o menor possivel para

diminuir o tempo necessario para o processamento dos dados.

Terrain Preprocessing =| Terrain Morphology = Watershed Processing = Attribute Tools » Network Tools = Aplitilities » O N ng B # Help o

Data Management Terrain Preprocessing

| DEMManipulation v Data DEM Manip
Flow Direction Create Drainage Line Structures
Adjust Flow Direction in Sinks Create Sink Structures
Adjust Flow Direction in Streams Level DEM
Adjust Flow Direction in Lakes DEM Reconditioning

Flow Accumulation Assign Stream Slope
Stream Definition Burn Stresm Slope

Stream Segmentation Build Walls

Combine Stream Link and Sink Link -
Sink Prescreening

Catchment Grid Delineation Sink Evaluation

Catchment Polygon Processing Depression Evaluation
Drainage Line Processing Sink Selection
Adjoint Catchment Processing Fill Sinks

Drainage Point Processing

Longest Flow Path for Catchments

Filll Sinks
Fill sinks in a DEM

Longest Flow Path for Adjoint Catchments
Accumulate Shapes

Slope

Rl el - ﬁ
CER b T -
Ther mvze Pz Bl -

L]
Hiydra DEM H
Use laSirk Fisld
il Mg
Fill Theoahold (DEM Z-Usi#) 1]
@ Fa M
[ Helg Caraed

2. Prossegue-se com a Dire¢do de Fluxo em “ArcHydro Tools” > “Terrain

Preprocessing” > “Flow Direction”. Neste caso, deve-se informar o arquivo “Fil” como
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Modelo Digital de Elevagdo, no campo Hydro DEM. Sera criado entdo um arquivo

chamado “Fdr” (Flow Direction).

D Flow Direction (]

Hydro DEM fil -

Flow Direction Grid Fdr

[ oK [ Help |[ Cancel |

Terrain Preprocessing ~ -

Terrain Morphology = Watershed Processing ~ Attribute Tools = Network Tools = ApLitilities =

2SR 4 Hep .

Dsta Management Terrain Preprocessing

DEM Manipulation

Flow Direction
Adjust Flow Direction in Sinks
Adjust Flow Direction in Stream| Flow Direction

Adjust Flow Direction in Lakes | Determine flow direction grid for a
DEM

Flow Accumulation
Stream Definition
Stream Segmentation
Combine Stream Link and Sink Link
Catchment Grid Delineation
Catchment Polygon Processing
Drainage Line Processing

Adjoint Catchment Processing
Drainage Point Processing

Longest Flow Path for Catchments
Longest Flow Path for Adjoint Catchments
Accumulate Shapes

Slope

3. Cria-se entdo o arquivo de Acumulacdo de Fluxo em “ArcHydro Tools” >
“Terrain Preprocessing” > “Flow Accumulation”. A Acumulag¢do de Fluxo (“Fac”) é

desenvolvida a partir da Direcao de Fluxo (“Fdr”).
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Temain Preprocessing ~| Terrain Marphology = Watershed Processing ~ Attribute Tools = Network Tools = ApUtilities~ 75, 2 o, == 53 TR B # Help _
T
7

Data Management Terrain Preprocessing

DEM Menipulation , )
Flow Direction !
Adjust Flow Direction in Sinks

Adjust Flow Direction in Streams

Adjust Flow Direction in Lakes

Flow Accumulation

Stream Definf £y Accumulation
Stream

TEAM &AM D etermine flow accumulation grid
Combine Str

Catchment Grid Delineation i

Catchment Polygon Processing
Drainage Line Processing

Adjoint Catchment Processing
Drainage Point Processing i
Longest Flow Path for Catchments | J
Longest Flow Path for Adjeint Catchments

Accumulate Shapes

Slope , o

o
T
@ Flow Accumulation |
Flow Direction Grid Fdr -
Flow Accumulation Grid  Fag
[ ok |[ Help |[ Cancel |

4. Prossegue-se com a Defini¢do de Fluxo em “ArcHydro Tools” > “Terrain
Preprocessing” > “Stream Definition”. Essa ferramenta estima os cursos d’agua

baseado no arquivo de Acumulagdo de Fluxo.

Em “Numero de Células”, atribuir o limiar que vai definir quais valores de
acumulagdo de fluxo serdo considerados corpos d’adgua e quais serdo apenas superficie
do terreno. Isso significa que todas as células do arquivo raster “Fac” que tiverem valor
superior ao limiar receberdo valor 1 (e serdo representadas como corpo d’agua) e todas
as outras serdo consideradas “NoData”. O valor padrdo € o valor recomendado para a
defini¢do de rios e representa 1% do maior valor de Acumulacdo de Fluxo. Qualquer
outro valor pode ser escolhido, lembrando que quanto menor o valor, mais densa ficara
a rede de cursos d’dgua resultante, j4 que mais valores de acumulagdo serdo
considerados corpos d’agua. Isto resultara em um raster com maior nivel de
detalhamento, ja que contemplara maior nimero de corpos d’agua. O raster resultante ¢
chamado “S#”.Pode-se testar os valores de limiar até encontrar o resultado mais

satisfatorio.
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Data Management Terrain Preprocessing
DEM Manipulation »
Flow Direction

Adjust Flow Direction in Sinks

Adjust Flow Direction in Streams

Adjust Flow Direction in Lakes

Flow Accumulation

Stream Definition

Stream Segmentation

Combine Stream Link and Sink Link| Stream Definition

Determine synthetic stream grid
based on a flow accumulation

Catchment Grid Delineation

thresheld

Catchment Polygen Processing
Drainage Line Processing

Adjoint Catchment Processing
Drainage Point Processing
Longest Flow Path for Catchments
Longest Flow Path for Adjoint Catchments

Accumulate Shapes

Slope

Terrain Preprocessing =| Terrain Morphology = Watershed Processing = Attribute Tools = Network Tools = ApUtilities~ 5, 2 &, - 52 BRI B # Help _
T

& Stream Definition

Flow Accumulation Grid

Enter stream threshold to inftiste & stream

Number of cells: 133755
Area (square km): 114260476
Stream Grid Str

5. O proximo passo ¢ a Segmentacdo dos Cursos d’Agua, em que se cria uma

grade com os cursos d’Agua que tenham a mesma identificacdo. “ArcHydro Tools” >

“Terrain Preprocessing” > “Stream Segmentation”. O arquivo raster resultante ¢

nomeado “StrLnk”.

Data Management Terrain Preprocessing
DEM Manipulation v
Flow Direction

Adjust Flow Direction in Sinks

Adjust Flow Direction in Streams

Adjust Flow Direction in Lakes

Flow Accumulation

Stream Definition

Stream Segmentation

Combine Stream || Stream Segmentation

Catchment Grid D|  Determine stream segment grid

Catchment Polygen Processing
Drainage Line Processing

Adjeint Catchment Processing

Drainage Point Processing

Longest Flow Path for Catchments
Longest Flow Path for Adjoint Catchments
Accumulate Shapes

Slope

Terrain Preprocessing +| Terain Morphology - Watershed Processing - Attribute Tools = Network Tooks - ApUtilities~ . 2 ®, =l 37 TR @ B # Help _
T
-
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==

-
Q Stream Segmentation

Flow Direction Grid Eb

4

Sink Watershed Grid
Sink Link Grid
Stream Link Grid Strlnk

[ ok |[ Help || Cancel |

6. Para fazer a delimitacdo das micro bacias, usa-se a ferramenta “Catchment Grid

Delineation”. “ArcHydro Tools” > “TerrainPreprocessing” >

“Catchment Grid

Delineation”. Esse procedimento ¢ feito com base no arquivo “StrLnk” e resulta em um

arquivo raster “Cat”.

==

Flow Direction Grid B -

-
Q Catchment Grid Delineation

Link Grid

g|[2
-y
g
4

Catchment Grid

[ ok ][ Help || Cance |

Terrain Preprocessing ~

Data Management Terrain Preprocessing

DEM Manipulation 3
Flow Direction

Adjust Flow Direction in Sinks

Adjust Flow Direction in Streams

Adjust Flow Direction in Lakes

Flow Accumulation

Stream Definition

Stream Segmentation

Combine Stream Link and Sink Link

Catchment Grid Delineation

Catchment Polygon Prof Catchment Grid Delineation

Drainage Line Processin

Determine catchment grid
Adjoint Catchment Proc
Drainage Point Processing

Lengest Flow Path for Catchments
Longest Flow Path for Adjoint Catchments

Accumulate Shapes

Slope

Terrain Morphology ~ Watershed Processing ~ Attribute Tools ~ Network Tools~ ApUtilities~ 5. 2 @, =l 32 ‘IE 3 P # Help _

7. Para vetorizar as micro bacias do arquivo raster “Cat”, clica-se “ArcHydro

Tools” > “Terrain Preprocessing” > “Catchment Polygon Processing”. O shapefile

resultante ¢ chamado de “Catchment” pelo ArcHydro.
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Data Management Terrain Preprocessing

DEM Manipulation 3
Flow Direction

Adjust Flow Direction in Sinks

Adjust Flow Direction in Streams

Adjust Flow Direction in Lakes

Flow Accumulation

Stream Definition

Stream Segmentation

Combine Stream Link and Sink Link

Catchment Grid Delineation

Catchment Polygon Processing |

Drainage Line Processint

Adjoint Catchment Proq Catchment Polygon Processing

Drainage Point Processi Determine catchment polygons

Longest Flow Path for Catchments
Lengest Flow Path for Adjoint Catchments
Accumulate Shapes

Slope

RS
NS
O

N
Ay
s

Q Catchment Polygon Pmoess...g

Catchment Grid
I

Catchment

Catchment

| o |

Help | [ Cancdl |

8. Gera-se agora a rede de drenagem em forma de vetor pelo caminho “ArcHydro

Tools” > “Terrain Preprocessing” > “Drainage Line Processing”. Este processo gera

um shapefile com o nome “Drainage Line” com base nos arquivos raster “StrLnk” e

“Fdr”, em que cada linha de drenagem ¢ identificada pela micro bacia a qual pertence.

Terrain Preprocessing =| Terrain Morphology = Watershed Processing = Attribute Tools = Network Tools = ApUtilities~ 5. 2 @, =} 52 ‘IE m P 4 Help _

Data Management Terrain Preprocessing
DEM Manipulation »
Flow Direction

Adjust Flow Direction in Sinks

Adjust Flow Directien in Streams

Adjust Flow Direction in Lakes

Flow Accumulation

Stream Definition

Stream Segmentation

Combine Stream Link and Sink Link
Catchment Grid Delineation

Catchment Polygen Processing

Drainage Line Processing ‘

Adjoint Catchmen| ESRLAPWR.ArcHydroTools.CmdDra

2 LineP, i
Drainage Point Pre inagetinetrocessing

Longest Flow Poth| ESRLAPWR ArchycroTaols CmdDr
inagel

Processing

Longest Flow Path

Accumulate Shapes

Slope

N | e 4
- %

SR

SN
A

% Y,

Sy
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r y
@ Drainage Line Processing ﬂ

Stream Link Grid
Flow Direction Grid

Drainage Line DrainageLine

[ ok ][ Help |[ Cance |

O shapefile criado nesta etapa (“Drainage Line”) servird de base para a

montagem do Diagrama Unifilar.

9. Clica-se entdo em “ArcHydro Tools” > “Terrain Preprocessing” > “Adjoint
Catchment Processing” e gerar shapefile “Adjoint Catchment”. Este arquivo apresenta

também as delimitagcdes das microbacias, mas em um nivel de detalhe um pouco maior.

Terran Preprocessing * | Terrain Morphology = Watershed Processing =  Attrib
| Data Management Terran Preprocessing .
DEM Marspulstion (N
Flow Directon ‘
Adpst Fiow Direction in Sinks
Adpst Flow Dwecton in Streams

s 5
Q Adjeint Catchment Processing @

Adpust Flow Direction n Lakes

Flow Accumulation
Stream Definton | Cactmer
Stream Segmentason Adjoint Catchment AdjointCatchment

Combine Stream Link and Sink Link

Catchment Grid Delineaton

Catchment Polygon Processing
Dranage Line Processing

| AdontCatchmentProcessing 1, | ]
Dranage Porit Processng — :

|
i [ oK ][ Help || Cancd |
\
\

Adjomt Catchment Processing
Longest Flow Path for Catchmen|

Determre adpont catchments
Longest Flow Path for Adjont Ca.
Accumulate Shapes
|
Sioe \

-

10. E preciso entdo gerar os pontos de exutorio das micro bacias para poder
delimita-las. Estes pontos sdo criados em “ArcHydro Tools” > “Terrain Preprocessing”
> “Drainage Point Processing”. Esta ferramenta utiliza varios dos arquivos criados até
aqui e cria um shapefile com diversos pontos, cada um correspondendo a uma das micro

bacias.
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Teerain Freprocessing =| Terrain Marphelogy = Watershed Processing =
| Dazamanagement Terrain Preprocessing i
DEM Manpulation 3
| Fieres Direcion
Adpust Flow Dinection in Srks
| Adjust Flow Direction in Streams
Adpust Fiow Direction in Lakes
Flere Acamubaion

'S B
Q Drainage Point Processing ﬂ

Flow Accumulation Grid fac -

Stream Definibon
Siream Segrmerlabon

Combing Straam Link and Sink Link Catchment Grid

Drainage Point DrainagePoint

Catchment Grid Delineason
Cabchment Polygan Processing
Drainage Line Processing
Adyoint Catchment Processing
Dranage Point Processing .,
Longest Fiow Path forCatchmés Drainage Print Processing
" f
Longest Flow Path for Adiont Caty p o b e oints
Acoumulate Shapes

0K |[ Help || Cancdl |

Shope

11. E necessério definir qual dos diversos pontos ¢ correspondente ao exutério da
bacia de interesse. Isso ¢ feito a partir de “ArcHydro Tools” >%2 (“Batch Point
Generation™). Essa ferramenta cria um shapefile chamado “BatchPoint” ¢ habilita o
cursor para selecionar o ponto de interesse no ArcMap. Clicando no ponto escolhido,
nomear a bacia correspondente e adicionar uma descri¢do. Com isso, o shapefile

“BatchPoint” tem somente o ponto do exutorio da bacia de interesse.

Mais adiante no processo de desenvolvimento do Diagrama Unifilar, utiliza-se
desta novamente para posicionar alguns pontos de interesse e calcular suas areas de

drenagem.

12. Para completar o procedimento, clica-se em “ArcHydro Tools” > “Watershed
Processing” > “Batch Watershed Delineation”. Essa ferramenta também utiliza varios
dos arquivos desenvolvidos até aqui, criando um arquivo chamado “Watershed” onde

estard delimitada a bacia hidrografica.
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Watershed Processing ~| Attribute Tools ~ Network Tools = Apltilities

Data Management Watershed Delineation
Data Management Watershed Characteristics Q Batch Watershed Delineation &]

Batch Watershed Delineation

Batch Subwatershed Delineation Batch Point
Batch Global Watershed Delinea Batch Watershed Delineation Flow Direction Grid
Batch Watershed Delineation fol Batch Watershed Delineation Stream Grid
Delineate from Multiple Inlets and Qutlets Snap Stream Grid
Drainage Area Centroid Catchment
Longest Flow Path Adijcint Catchment
Lengest Flow Path for Watersheds R Viatershed

Longest Flow Path for Subwatersheds \nfatershed Point VatershadPot

Main Flow Path

Construct 3D Line
Smooth 30 Line

Flow Path Parameters 3

Basin Length Points ]

Basin Length ]

2.1.6. Detalhamento das Linhas de Drenagem

As linhas de drenagem que serdo utilizadas como base para o tragado do

Diagrama Unifilar estdo no arquivo “DrainageLine”, criado anteriormente.

Para complementar as informagdes, também pode ser util consultar o arquivo
“fac”, que pode acrescentar informagdes mais detalhadas sobre as linhas de drenagem
da area. Para que o arquivo “fac” apresente informagdes relevantes, deve-se configurar
sua exibi¢do clicando com o botdo direito do mouse sobre o arquivo e selecionando
“Propriedades”. Na aba “Simbologia”, selecionar no campo “Mostrar” a opgao
“Classificado”, definir o nimero de classes e clicar em “Classificar...”. No campo
“Quebrar valores” deve-se definir as novas classes. Valores com alto grau de detalhe
podem ser, por exemplo: 50, 100, 150, 200, 250. Os valores podem ser modificados
novamente de acordo com a necessidade ao longo do processo de montagem do

Diagrama Unifilar.
Definir o Rio Principal

O primeiro passo para montar o Diagrama Unifilar € definir o rio principal da sub-
bacia em questdo. Com base na Ottocodifica¢do de bacias hidrograficas, define-se como
rio principal aquele com maior area de drenagem. Sendo assim, a partir do exutorio
definido nos passos anteriores, deve-se percorrer o tragado de drenagem, de jusante a

montante, optando-se sempre pelo curso d’agua com maior area de drenagem.

Em caso de duvida sobre qual das opgdes de tracado tem a maior area de

drenagem, seguir este passo a passo:
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Definir um “BatchPoint” em cada um dos trechos e gerar a area de
drenagem, como feito anteriormente, mas de preferéncia em um novo
arquivo. Para isso, basta escolher novos nomes para os campos
“Watershed” e “Watershed Point”.

Para calcular a area, deve-se clicar com o botdo direito do mouse no
shapefile gerado com as areas de drenagem e selecionar “Abrir Tabela de

Atributos”.

Em “Opgoes da Tabela” (H ) selecionar “Adicionar Campo...”, nomea-

lo “Area” e definir como tipo “Duplo”.

Clicar com o botdo direito do mouse sobre o cabegalho do novo campo

criado e selecionar “Calcular Geometria...”.

e No campo “Propriedade” definir como “Area”

e Como “Sistema de Coordenadas”, utiliza-se a projecdo Lambert com
sistema de coordenadas, ou datum horizontal, referenciado ao Datum
SIRGAS2000 (para isso basta definir este sistema de coordenadas
para a estrutura de dados — como mostrado na figura abaixo — e
marcar esta op¢ao para o calculo da area).

e No campo “Unidades” ¢ comumente adotado “Quilometros
quadrados”, mas neste caso qualquer uma das opgdes ¢ valida, visto
que o objetivo é somente comparar as duas opgoes e definir qual dos
trechos do rio tem a maior drea de drenagem e por isso segue como rio

principal.

Este procedimento deve definir um rio principal, do exutorio até a nascente.

28



Table Of Contents T x

- Data Frame Properties @1
8GE|E

Feature Cache | Annotation Groups | Estent Indicators | Frame | Size and Position
EF= | | :
- ¢) Add Data.. | Geneml | DataFame | Coordimate System | llumination | Gids |

%;‘j Mew Group Layer

2 A > - ; *
o & Mew Basemap Layer =_= v‘ Type here to search v @ @ | CLF - 5t
@

Co = 5% Favorites
=] [ @ Py ==
" ] SIRGAS 2000
=] SE @ South_America_Lambert_Conformal_Conic
£ Geographic Coordinate Systems
a D Turn All Layers On 5 Projected Coordinate Systems
5 Layers
_ Turn All Layers Off Y
O Fd Select All Layers
O A Expand All Layers
& Ex
= = Collapse All Layers -
g Al Current coordinate system:
=l 76 Reference Scale 3 GC5_SIRGAS_2000 *
O WKID: 4674 Authority: EPSG

Advanced Drawing Options...
3 angular Urit: Degree (0,0174532925193433)
Labeling + Prime Meridian: Greenwich (0,0)
Datum: D_SIRGAS_2000

Spheroid: GRS_1980
“4g  Convert Features to Graphics... Semimajor Axis: §378137,0
Semiminor Axis: 6356752,314140356
Inverse Flattening: 298,257222101

Activate

||'i‘r Properties...

Data frame Properties

Change the properties of this data
frame, such as the coordinate
systern it uses,

Recomenda-se a criacdo de um novo shapefile contendo apenas o rio principal.
Este shapefile serd utilizado mais adiante no calculo das distdncias e facilitara a
visualizagdo durante a montagem do diagrama. E interessante representar este rio com
destaque sobre o resto dos trechos de drenagem para facilitar. Para que esse rio seja
representado por uma unica linha, ao invés de diversos pequenos segmentos, basta
utilizar a ferramenta Dissolver em “Ferramentas de Gerenciamento de Dados” >

“Generalizagao” > “Dissolver”.

2.1.7. Projecao para calculo de areas (Conica Conforme de Lambert)

Para o calculo de area de poligonos de area de drenagem, pode-se utilizar
diferentes projecdes. A mais adequada para quando se trabalha com grandes bacias em
médias latitudes € a projecdo conica conforme de Lambert. Utiliza-se essa por ser uma
projecdo também de cone secante (cone que corta o elipsoide, no caso, GRS80, em dois

paralelos de referéncia, standard parallels). Isso minimiza distorc¢oes.

Para se adicionar esse sistema de coordenadas no ArcGIS, clica-se com botdo
direito em camadas, “Layers”, e abre-se propriedades, “Properties...”, clica-se em
“Coordinate system”, clica-se em sistema de coordenadas, “Coordinate System”,

procura-se por Lambert. Expande-se sistema de coordenadas projetadas, “Projected
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Coordinate System”, Continental, “Continental”, América do Sul, “South America”, e

clica-se duas vezes em “South America Lambert Conformal Conic”.

L] o

Na janela de “Projected Coordinate System Properties”, definem-se os parametros
da projecdo de Lambert. Os valores dos parametros que precisam ser necessariamente

alterados encontram-se nesse sitio.

Deve-se ainda alterar o sistema de coordenadas geografico. Para tal clica-se em

alterar, “Change...”, e seleciona-se o sistema SIRGAS2000, cujo codigo WKID ¢ o

4674. Clica-se “OK”. Nota-se que a projecdo criada, “Lambert exemplo”, apareceu na
pasta de projecdes customizadas, “Custom”. Pode-se clicar em seguida em 3* para se
adicionar aos favoritos. Por fim, clica-se em OK, e a projecdo estd definida, pode-se

partir para o calculo das areas.
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2.2. Utilizando o QGIS

O software ArcGIS ¢ bastante utilizado para andlises hidroldgicas, porém esse
requer licenca. Esta licenca ¢ paga e necessita de internet para se manter valida.
Acreditamos ser interessante ter em maos um software alternativo porque dinheiro deve
sempre ser poupado em ambas esferas privada e publica, ¢ ndo se deve ficar
dependendo sempre da disponibilidade de internet. E nessa conjectura que nasce esse
topico sobre utilizagdo do QGIS para confec¢do de um Diagrama Unifilar.

O software QGIS, Quantum Geographic Information System, ¢ semelhante ao
ArcGIS, porém ¢ um software livre sob a licenca de softwares livies GNU GPL,

fazendo parte do OSGF, Open Source Geospatial Foundation. Ele trabalha

principalmente com a linguagem Python.

2.2.1. Caminhos relativos no QGIS

Semelhante ao ArcGIS, hd a opgdo de utilizar caminhos relativos também no
QGIS. Altera-se nas configuragdes de projeto, “Project Properties...”, o “Save paths”

para “relative”, e clica-se “OK”, depois ainda se salva o projeto. Estara salvo entdo com

caminhos relativos.
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2.2.2. Importar Inventario ANA de formato .mdb para QGIS

Primeiramente se segue o enunciado do item “a.” até¢ “d.” no item 2.1.2 desse

mesmo tutorial.

Em seguida, deve-se abrir o arquivo Excel de estacdes exportado do Access

depois das consisténcias feitas, e salva-lo em formato “.csv” (i.e. “CSV (separado por

virgulas)” ).

Depois, deve-se abrir o QGIS Desktop,

Delimited Text Layer...”, ou, clicar no icone * 9.
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clicar em “Layer”,

“Add Layer”, “Add

Feito isso uma janela abrira. Nela, deve-se arrumar algumas configuracoes. Deve-

se primeiro clicar em “Browse... ”, selecionar o arquivo em formato “.csv”, e carrega-lo.

Em seguida, ajusta-se o “Encoding” para “windows-1252" (esse passo € importante

para o QGIS reconhecer os caracteres do arquivo, especialmente os acentos das palavras

que nao sdo comuns a lingua inglesa).

Depois, seleciona-se “Custom delimiters” em “File format”, desmarca-se todos

delimitadores, adiciona-se em “Other delimiters” o ponto e virgula, “;

€,

, mantem-se as
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outras configuragcdes como presentes na imagem abaixo e, por ultimo, mas ndo menos
importante, checa-se se os dados parecem estar corretos na tabela de pré-visualizagdo
(e.g. 0 que aparece escrito como titulo da coluna 0 combina com os dados da coluna); é

sempre bom que se cheque. Finalmente, clica-se ok.

Em seguida, outra janela abrira, perguntando qual o sistema de coordenadas de
referéncia a ser utilizado pelo QGIS. Como comentado anteriormente nesse tutorial,
utiliza-se 0 SIRGAS2000 como sistema oficial de coordenadas geograficas do Brasil.

Assim, seleciona-se o0 SIRGAS 2000, de cédigo EPSG: 4674, e clica-se em OK.

/. Coordnste Reference System Sebectar [

M| ssecty cR forayer Esincan

sty ID

[ 6
EPSGA6TI
EPSGI8E

Aspeity D
EPSGAETS
EPSGABE
EPSGAB2
EPSGA3S
EPSGATS0

Pode-se ja visualizar os dados na tela. Esses, porém ainda ndo estdo salvos em
formato shapefile. Logo entdo, clica-se com o botdo direito no layer, e seleciona-se

“Save As...”".

33



£ qeis 2182
Proect EA yew laer fetnm Dugm wom Gmi Dssbe g WKGE 5P oy beo
=y W [ w
c (-}

BRI A0S L£L s HPPL A
C o= O BB ik FLY

-

5]

(]

NSEBrSH88NN

Coordnaie. 2207604 B sk s -

Outra janela abrird na qual se especifica as configuragdes para exportacdo do
arquivo para diferentes formatos e outros dados. Nesse caso, gostariamos que o formato
exportado seja ESRI Shapefile, pois talvez se venha a utilizd-lo no ArcGIS (programa
da ESRI que popularizou o formato shapefile, i.e., “.shp”). E importante que em
Encoding esteja “windows-1252". Pode-se manter selecionado “Add saved file to map”
caso se pretenda utilizar/visualizar o shapefile em seguida. Note que o CRS (Sistema de
Coordenadas de Referéncia, Coordinate Reference System) escolhido ¢ aquele oficial do

Brasil, SIRGAS2000.

eamey tem s

Caso ndo se tenha marcado a op¢do de adicionar o shapefile apos exportagao,

pode-se ainda adicionar o arquivo shapefile exportado da seguinte maneira:

Clica-se em “Layer”, “Add Layer”, “Add Vector Layer...”.
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Uma janela abrird e nessa deve-se especificar que se adicionard um “File”, de
Encoding “windows-1252", clica-se em Browse e abre-se o shapefile salvo. Deve-se

selecionar o arquivo de formato “.shp”.

Voila! 14 estard o shapefile pronto para ser utilizado, e com os caracteres

portugueses devidamente interpretados.

Togples the edtig stateof he curent aver Coordrate

10710, %.72 ® scl s - @ Meofe 00% 5 Rewin 00 ¢ [WRed DEwan @

2.2.3. Selecio das estacoes de interesse

Ap6s importar os dados, prossegue-se com o recorte dos dados realmente
necessarios para o estudo. No QGIS, pode utilizar as ferramentas sele¢do por figura por
equacdo (1), geométrica (2), e por local, Select by location (3). Faz-se necessario apenas
que ao utilizar (2) mantenha-se “shift” pressionado para somar a selecdo, e que, no caso
de fazer uso de mais de um método de selegdo, usar sempre o de equacdo primeiro para
iniciar a selecdo porque apenas os outros apresentam opg¢do de “somar a selecdo

existente”.
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Ao utilizar a op¢ao (3), atenta-se para opcao “adding to current selection” para

adicionar a sele¢do que esta sendo usada.

Clicando-se com o botdo direito na camada e em “Save As...”, define-se o local
onde o arquivo serd salvo em “Browse”, depois se marca “Save only selected features”
como mostrado em imagem abaixo. Assim, serdo salvas as fei¢cOes selecionadas da

camada em formato “ESRI Shapefile”.

18.6
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2.2.4. Estimar altitude de pontos de interesse via SRTM30 no QGIS

Faz-se necessario estarem abertos os pontos de interesse dos inventarios ANA e

ANEEL e o raster de MDE. Aqui, utilizaremos um raster derivado do SRTM30.

Normalmente, o QGIS ndo possui o plug-in para extrair valores de um raster para
um shapefile. Para adicionar o plug-in, clica-se em “Plugins”, “Manage and Install

s

Plugins...”,
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procura-se por “point sampling tool”, clica-se em “Install plugin”.

Point sampling tool
attributes and
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Uma janela abrird e com ela o download iniciara
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Alguns instantes depois, o plugin estard instalado, e a janela mudara, ficando

assim:

| L PP
Point sampling tool
Samples polygon attributes and raste

from multiple layers at specified samj
points.

The Point Samping Tool Plugin colects palygon &

Em seguida, clica-se no icone de “Point sampling tool”.
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Uma janela abrird. Nela, seleciona-se quais os campos que constardo no layer a
ser criado. Normalmente, seleciona-se todos os campos do layer de estacdes, os quais

estdo todos com “(source point)” escrito, mais a banda do raster de que se pretende
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extrair os valores de altitude. Também escolhe-se o nome do shapefile de saida. No
caso, escolheu-se “2017-01-27 Estacoes SB88 Altitude”. Note aqui que o nome tem
mais de 13 letras, e embora isso pudesse ser um problema para o ArcGIS, ndo ¢ deveras

um impeditivo para o QGIS. Clica-se entdo em OK. Abaixo segue imagem:

Note que agora o shapefile de saida ¢ idéntico ao de entrada, com a excecdo de

possuir uma ultima coluna com o nome do raster utilizado, e os respectivos valores
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Deve-se fazer um adendo aqui que as altitudes extraidas pelo ArcGIS sdo
interpoladas, porém, no QGIS, utilizando-se esse método aqui mostrado, as altitudes
extraidas sdo do pixel inteiro. Como contornar isso? Recortado o MDE da regido,
reprojeta-se ele com uma resolucdo maior, e refaz-se o processo de extracdo de altitudes

por ponto.

O processo para extragdo de valores de um raster qualquer para uma camada de
pontos qualquer ¢ o mesmo. Sendo assim, para o caso dos barramentos, basta realizar o
mesmo procedimento, alterando-se a camada para qual os valores do raster sera

extraido na lacuna de “Layer containing sampling points”.
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2.2.5. Processamento de MDE para analise espacial no QGIS

Para delimitar uma Bacia Hidrografica no QGIS, é necessario primeiramente
possuir um arquivo MDE. Para confec¢do dos diagramas unifilares, ¢ de praxe utilizar
os dados de elevacao do SRTM30 como comentado acima. Nosso interesse costuma ser
delimitar uma bacia hidrografica para calcular a area de drenagem e comparar com o
dado presente no inventario das estacdes fluvio e pluviométricas da ANA. O inventario
de estagdes da ANA ¢ composto de varios dados enviados por diferentes pessoas, que
utilizaram diferentes métodos para estimar a altitude, a area de drenagem e a posicao
real de suas respectivas estagdes. Algumas estagdes sdo antigas, € por isso utilizaram
métodos antigos. Hoje, com o artificio do SRTM30, pode-se aprimorar o processo de
consisténcia de dados. Ainda, porém, ¢ evidente que a resolugdo do SRTM30, e o fato
desse ser um MDE e ndo um Modelo Digital de Terreno nos apresenta algumas

limitagOes na analise.

Além do MDE, também se faz necessario possuir o inventario de estagdes da
ANA em formato shapefile. No item 2.2.2 consta como importar dados de uma planilha

Excel para o QGIS.

A maneira mais pratica de demonstrar o processo ¢ realizando um exemplo.
Sendo assim, delimita-se em sequéncia a area de drenagem da estagdo 70600000, de

nome UHE Barra Grande Vacas Gordas.

Adiciona-se, primeiramente, o shapefile das estagdes e 0 MDE do SRTM30. Para
tal, usa-se o atalho “Ctrl+Shift+R”, ou clica-se em “Layer>Add Layer>Add Raster

Layer...”.

Uma janela abrird e nela se deve selecionar o arquivo raster em formato “.tif” a

ser utilizado. Em seguida, clica-se em abrir.
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Caso se venha utilizar um recém formado mosaico derivado do SRTM30, havera
informagdo desnecessdria para os subsequentes processos dispendiosos. Portanto, ¢
sabio extrair apenas o espaco do MDE que sera utilizado. Como saber que espago sera
utilizado? Quando se pretende delimitar uma 4area de drenagem de uma estagdo,
hidrologos costumam ter uma intuicdo do qudo grande essa pode ser e delimitam

normalmente um espago, ainda assim, bem exagerado no qual possivelmente consta

toda a area de drenagem.

E necessario, porém, desenhar essa area a ser extraida no préprio QGIS. Portanto,
criaremos na sequéncia um shapefile. Clica-se tanto “Ctrl+Shift+N”, ou “Layer>Create

Layer>New Shapefile Layer...”.

DD

Uma nova janela abrird. Nela se define que o tipo de shapefile sera um
“Polygon”, de Encoding “windows-1252”, de coordenadas geograficas “SIRGAS-
20007, cujo codigo EPSG ¢ 4674, e clica-se Ok.
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Em seguida, outra janela abrird, perguntando em que local deve ser salvo esse
novo Shapefile. Sugere-se salvar em algum local de facil acesso, com algum nome
como “para extracdo” ou “extrair”. Esse Shapefile podera ser depois de usado
prontamente deletado. Esconlhendo-se o nome e salvando-se ele, o mesmo aparecera no

canto esquerda em Layers Panel.

Para desenhar a fei¢ao, clica-se com botdo direito no layer e seleciona-se “Toggle

Editting”.

Depois, clica-se em Add Feature. Caso ndo conste essa opcdo na barra de
ferramentas no topo da janela principal, deve-se clicar com o botdo direito na parte

cinza no topo e selecionar “Digitizing Toolbar”.
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Clicando-se em Add Feature, deve-se agora desenhar a fei¢do a ser extraida do
MDE. Para desenha-la, clica-se com o botao esquerdo um a um, adicionando-se vértices
a fei¢do. Completado o desenho, clica-se com o botdo direito para o programa saber que

a feicao esta desenhada.

Uma janela abrird perguntando qual o “id” dessa feicdo. Quando se pretende
desenhar mais fei¢des, ¢ importante adicionar um codigo para diferenciar as feigdes,
examinando a tabela de atributos do /ayer. Dado que usaremos apenas uma feigdo para

extracdo, pode-se tanto ndo escrever nada, como botar algum ntimero.

unw—mmi
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Agora, deve-se salvar as edi¢des feitas. Clica-se, portanto, em “Save Layer
Edits”. Por fim, deve-se sair do modo de edi¢do do Layer. Para tal se clica em “Toggle

Editting” que estd ao lado esquerdo de “Save Layer Edits” .
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Prossegue-se com a extragdo do MDE pelo Layer criado. Clica-se em

“Raster>Extraction>Clipper...”.
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Abrird uma janela, na qual se define qual o raster que sofrera a extracdo, o local
onde essa extracdo serd salva, e se 0 modo de extragdo sera dado por Extent ou Mask
layer. Abaixo consta imagem. E bastante importante garantir que “Crop the extent of the
target dataset to the extent of the cutline” esteja marcado, do contrario gerar-se-a um

raster de mesma extensao que o original, com varios pontos “sem data”, NoData.

Deu-se o nome de “MDE30 SRTM extraido” para o arquivo de saida. Clica-se

em OK.

43



Caso apare¢a uma mensagem de erro com a notificagdo “QOutput driver 'GMT'
not recognised or does not support direct output file creation.”, altera-se o codigo
programacional. Para isso, depois de definir todas configura¢des do processo, clica-se
no icone de edicdo (Edit) de lapis laranja, e altera-se o codigo programacional de “-of

GMT para “-of Gtift”.

O processo costuma ocorrer de maneira bem rapida mesmo para bacias grandes,
dependendo o tempo de processo do raster de entrada (tamanho do pixel, nimero de
pixels, do tipo de data — string, float, double, integer) e do niimero de vértices do
poligono usado como Mask Layer. Caso seu processo esteja demorando muito mais de 6
minutos, pode ser que tenha se esquecido de marcar “Crop the extent of the target

dataset to the extent of the cutline”.

Assim como no ArcGIS, agora serdo feitas diversas operacdes para criar layers de

direcdo de escoamento e de acumulacdo de escoamento. Para tal, utilizar-se-a
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algoritmos do SAGA, System for Automated Geoscientific Analyses, (2.1.2) e do
GRASS, Geographic Resources Analysis Support System. Ambos sdo programas livres
de GIS, cujos algoritmos foram adicionados na ferramenta de processo do QGIS (pode-

se dizer que € um “ArcToolBox do QGIS™) .

Primeiro, adiciona-se a Processing Toolbox, na qual se encontra os algoritmos
dos SAGA e GRASS. Pode-se clicar também “Ctr/+Alt+T”, ou clica-se em

“Processing” e depois em “Toolbox”.

Feito isso, expande-se o “SAGA (2.3.2)”, “Terrain Analysis — Hydrology”, e
depois duplo clique em “Fill Sinks xxl (wang & liu)”. Semelhante ao processo do
ArcHydroTools, o “Fill Sinks xxl (wang & liu)” preenchera depressdes. Se isto nao fosse
feito, os algoritmos, ou processos, posteriores interpretariam que a 4agua ficaria

estagnada eternamente nessas tais depressoes.

- —
R
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Para mais informagdes sobre esse processo, desenvolvido por Wang & Liu, pode-

se acessar este sitio:

Esse processo ¢ tipicamente utilizado para bacias maiores, por isso 0 nome de
“xx1”. Caso queira-se trabalhar com bacias menores, pode-se empregar o “Fill Sinks
(wang & liu)”, que é mais completo, apresentando como dados de saida ndo s6 o MDE
sem depressdes, como também um raster de direcao de escoamento (Flow directions) e

de bacias hidrograficas (Watershed basin). Mais informacgdes no sitio:
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http://www.saga-gis.org/saga_tool_doc/2.2.5/ta_preprocessor_5.html
http://www.saga-gis.org/saga_tool_doc/2.1.3/ta_preprocessor_4.html

Dando-se duplo clique em “Fill Sinks xxI (wang & liu)”, abre-se uma janela na
qual se define qual raster terd suas depressoes preenchidas, e qual a minima declividade

que ¢ considerada uma depressao. Utiliza-se o valor padrao de 0.01.

Em seguida, prossegue-se com os processos para obter a dire¢do de escoamento e
acumulacdo de escoamento. Para tal ¢ usado o algoritmo “r.watershed”. O dado de
entrada serda o DEM com as depressdes preenchidas que foi gerado pelo algoritimo
anterior. Em “minimum size of exterior watershed basin”, utiliza-se um valor de 1000.
Esse parametro determina o tamanho minimo considerado pelo algoritimo como sendo
uma bacia individual, mas j& que ndo estamos interessados no dado de saida “Basin”,
apenas queremos que o programa nao tranque, € por isso o valor de 1000 ¢ adequado.

As vezes pode ser necessario um valor maior para evitar que o algoritmo colapse.

Mantém-se marcado apenas “Number of cells that drain through each cell”,
“Drainage direction” e “Stream segments”. O primeiro retorna a acumulacdo de
escoamento, o segundo a dire¢do do escoamento, € o terceiro os cursos de dgua. Sugere-
se clicar nas reticéncias para salvar os arquivos gerados (Save to file). O “Stream

segments” € especialmente importante que seja salvo. Clica-se, por fim em “Run’.

Esse processo ndo levou mais de 6 minutos. Normalmente, o /ayer de escoamento

acumulado (“Number of cells that drain through each cell”’) ndo ¢ gerado com uma boa
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simbologia, ndo sendo assim visualizavel. Esse, porém, ¢ bastante importante para

definirmos corretamente o ponto do exutério referente a area de drenagem a ser

calculado. Portanto, abre-se as propriedades do raster de escoamento acumulado.

%

B Sy 85

Vool R mesan  sapecrsiomLaye

n Styles

Ll I R
LKl Save s Layer Defition Fil..

Brepesies

[

Em “Style”, expande-se em “Load min/max values”, seleciona-se “Mean +/-
standard deviation x 2,00”. Esse processo define novos valores de minimo (média dos
valores de todas as células do raster menos dois desvios padrdes) e maximo (média dos
valores de todas as células do raster mais dois desvios padrdes) para uma simbologia
em gradiente de preto até branco, sendo mais escura a célula com baixo nimero de
escoamento acumulado, e mais clara aquela com grande numero de escoamento

acumulado.

Clica-se logo abaixo em “Load”, e depois em “Apply”. Dessa maneira, o raster

sera mais bem visualizado.
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 Color rendering

Em seguida, localiza-se a posicdo da estacdo de interesse. Nesse caso, a
70600000.
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E notéavel que a estagdo nao esta exatamente sob a célula em que se concentra a
drenagem (ou, no caso, onde “possivelmente” se encontra o curso d’adgua). Pode-se

utilizar aqui também a camada salva de “Stream Segments”.

Em seguida, utiliza-se o “r.water.outlet”. Como dado de entrada, seleciona-se o
raster de dire¢do de escoamento (Drainage direction), o qual foi gerado no processo de
“r.watershed”. E também necessario apontar qual ponto devera ser considerado o
exutorio dessa area de drenagem. H4 um recurso nesse processo que consiste em clicar
na reticéncia a direita da lacuna de “Coordinates of outlet point(x,y)”. Clica-se na

reticéncia.

p—

[ p—
[oranage deecaan P56 41401
[ ——)

(GRASS GIS 7 regan extent (s, xma, o, peas]
A GIS 7 regan cebstm (e 0 for defu)
00000

Basn

1 pen autt e afer rurving alonthe

(Con [ oo

A janela do algoritmo se minimiza. Em seguida, clica-se na célula do curso

d’4gua mais proxima da estacdo. Porém, qual célula é essa? As vezes ¢ facilmente

possivel ter uma ideia no simples olhar, mas em outras a ferramenta ™ ~ pode ser
bastante util para medir a menor distancia do ponto de interesse até a drenagem. Com
essa ferramenta também ¢ possivel medir, a grosso modo, a area de drenagem da
estacdo, dado que a projecdo utilizada esteja em metros e seja condizente com a area

(2.2.7). Escolhendo o ponto na drenagem, a mesma janela anterior aparece novamente.
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Note que agora a coordenada (X,y) ja consta na lacuna. Clica-se entdo em “Run’.

Pronto, em poucos segundos o raster da bacia é gerado.

Porém, ainda falta transformar esse arquivo raster em formato shapefile.

Felizmente, ha um algoritmo chamado “r.fo.vect” no proprio grupo de algoritmos do

GRASS.

Abrindo o “r.to.vect”, adiciona-se como dado de entrada o raster da area de
drenagem calculada como “Input raster layer”, define-se “area” como “Feature type”, e,
dependendo da aplicacdo, seleciona-se “Smooth corners of area features”. Quando o
objetivo for calcular a area segundo o SRTM30, considerando a resolugao de 30 metros,
sugere-se manter essa ultima opgdo desmarcada porque quando marcada essa tem

carater tdo puramente estético (i.e. essa op¢do quando marcada suaviza o raster).

Clica-se entdo em “Run”. Esse processo ¢ bastante rapido e ndo levou mais de 20

segundos. Abaixo segue imagem da janela ja configurada.

) e - s s o s 1
e [FrTerT.

It ot nger
B PG 140] =)

smooth cornars of res foatres
GRALS QIS Tregen extent e, ama, ymn, yax)

B Advanced parameters
wetred

7] Opan cutput e after v wgents

Voiala! Pode-se visualizar a area de drenagem.
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Tiswoof? 16

O usuario mais atento, deve ter notado desde o processo de “r.watershed” que gera
os layers de dire¢do de escoamento e acumulo de escoamento, os layers criados estavam
em EPSG:4140, e o shapefile de area de drenagem gerado esta em EPSG:4019. J& que
pretendemos trabalhar com o SIRGAS2000, agora, por fim, exporta-se o shapefile no
sistema de coordenadas SIRGAS2000.

Para tal, em “Layers Panel”, clica-se com o botdo direito no shapefile gerado,

seleciona-se “Save A4s...”.

7615 2186 - Arquivo 64 Tate
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Eropesties giinio0
Regame

A seguinte janela abrira, e nela deve-se especificar o “Format” como “ESRI
Shapefile”, definir o endereco em que o aquivo serd salvo (clicando-se em “Browse”),
manter como “CRS” o “Project CRS (EPSG:4674 - SIRGAS 2000)”. Mantem-se o
Encoding como “windows-1252" por ser esse bom para interpretar caracteres

portugueses, e também seleciona-se “Add saved file to map”.
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2.2.6. Detalhamento das Linhas de Drenagem

Abre-se o arquivo de cursos d’agua, Stream segments, o qual foi gerado no item
2.2.5. Abre-se o algoritmo r.thin do GRASS, e, definindo-se um limite de 200
interacdes para o algoritmo, e salvando-se (reticéncias) na lacuna abaixo de “Thinned”,

clica-se em Run.

B o process

Em seguida, utiliza-se novamente o r.to.vect do GRASS para vetorizar o raster
gerado. Dessa vez, porém, seleciona-se “line” para Feature type, € escolhe-se um local

seguro para salvar o vetor gerado (lacuna em baixo de Vectorized).

Definir o Rio Principal

O primeiro passo para montar o Diagrama Unifilar ¢ definir o rio principal da sub-
bacia em questdo. Com base na Ottocodifica¢do de bacias hidrograficas, define-se como
rio principal aquele com maior area de drenagem. Sendo assim, a partir do exutorio
definido nos passos anteriores, deve-se percorrer o tragado de drenagem, de jusante a
montante, optando-se sempre pelo curso d’agua com maior area de drenagem, ou ainda,
com maior acumulagdo de escoamento (pode-se utilizar simples o raster de acumulagao

de escoamento).

Em caso grandes duvidas sobre qual das opc¢des de tracado tem a maior area de
drenagem, deve-se utilizar o r.outlet do GRASS, utilizando também o arquivo de

direcdao de escoamento ja gerado no item 2.2.5.

Seleciona-se de um em um os segmentos de rio até a nascente, utilizando a
ferramenta identificar () e as ferramentas de sele¢do descritas em 2.2.3 . Salienta-se
aqui que se deve manter o botdo shift durante o processo. Recomenda-se a criacdo de
um novo shapefile contendo apenas o rio principal no final. Este shapefile sera utilizado
mais adiante no célculo das distancias e facilitard a visualizagdo durante a montagem do

diagrama. E interessante representar este rio com destaque sobre o resto dos trechos de
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drenagem para facilitar. Para salvar o selecionado como shapefile, clica-se com o botao

direito sobre a camada, seleciona-se “Save as” e marca-se “Save only selected features.

SDIBININS

hd

)

2.2.7. Projecao para calculo de areas (Conica Conforme de Lambert)

Para o calculo de area de poligonos de area de drenagem, pode-se utilizar
diferentes projecdes. A mais adequada para quando se trabalha com grandes bacias em
médias latitudes ¢ a projecdo conica conforme de Lambert. Utiliza-se essa por ser uma
projecdo também de cone secante (cone que corta o elipsoide, no caso, GRS80, em dois

paralelos de referéncia, standard parallels).

Para se adicionar esse sistema de coordenadas no QGIS, ¢ necessario criar um

“Custom CRS”. Clica-se em “Settings”, “Custom CRS...”.

f qeis 2180
et gt gem Loy (b ggn: weow gmie
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Uma janela abrira. Nela, clica-se no simbolo de “ + . Define-se o nome da
projecao (Name). Sugere-se digitar algo que inicie por “Lambert ” e acabe com a bacia
que esta se propondo a calcular a area de drenagem. Em Parameters, deve-se digitar o

codigo referente a projecao Lambert daquela bacia.

Abaixo segue exemplo do codigo digitado para Sub-Bacia 85, e uma breve

explicagdo de cada comando utilizado na linguagem proj.4.
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+proj=lcc +lat_1=-28.584 +lat_2=-30.364000000000004000
+lat_0=-9.254833333333330000 +lon_0=-53,119999999999997000
+x_0=0 +y_0=0 +ellps=GRS80

+towgs84=0.48,0.49,-0.3,0,0,0,0

+units=m +no_defs

Segue explicagdo breve dos codigos:

+proj=lcc (define que a projegao ¢ Lambert Conformal Conic)

+lat 1= (define o primeiro paralelo)

+lat 2= (define o segundo paralelo)

+lat 0= (define a latitude de origem)

+lon_0= (define o meridiano central)

+x 0= (define o falso leste)

+y 0= (define o falso norte)

+ellps=GRS80 (define o elipsoide de origem)

+towgs84=0.48,0.49,-0.3,0,0,0,0 (define a relagdo com 0 DATUM wgs84)
+units=m (define que as unidades serdo representadas em metros)
+no_defs (define que nenhuma opgdo “default” serad lida dos arquivos “default”.

Algumas vezes, a omissdo desse comando pode causar erros surpreendentes como

consta aqui)

Os valores desses parametros para cada Sub-Bacia podem ser obtidos no seguinte
sitio. Nesse mesmo sitio também consta breve explicacdo para a estimativa desses

parametros.
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http://lists.osgeo.org/pipermail/mapserver-users/2003-November/046863.html
https://drive.google.com/open?id=0B08viPHIwmy2OUVpYnNSbXJQYm8

Mais informacdes sobre a projecdo conica conforme de Lambert podem ser
obtidas na pagina 104 do Map Projections — A working manual, o qual estd disponivel

nesse sitio.

Depois de criada a projecdo exata a ser utilizada para calcular a 4&rea com menor

deformacao, clica-se no canto inferior direito para alterar o sistema de projecao.

00% %] iotatior 0,0 % [¥] Render | € EPSG:3857 (OTF)

T — >
i Current CRS: WGS 84 f Pseudo Mercator (OTF enabled) m

Uma janela abrira. Nela, procura-se a nova projecdo adicionada. Aqui, no caso,

deu-se 0 nome de “Lamber SB_85” porque com essa projecdo calculou-se a area de
drenagem ndo s6 da Sub-Bacia 85, como também de outras estagdes que nela
encontravam. Para facilitar a busca, pode-se utilizar o “Filter”: esse consiste em
localizar projecdes segundo a palavra titulo. Proje¢des adicionadas pelo usudrio
aparecem na categoria “User defined Coordinate Systems”. Aqui se filtrou por

“Lambert”. Seleciona-se a proje¢ao, e clica-se em “Ok”. Segue imagem abaixo.

2 e gt | OB ~ = -l e - - - - e =
7 Enable ‘on the fiy’ (RS transiormation (011)

2.2.8. Simbologia no QGIS

Os autores desse trabalho desenvolveram uma simbologia para os diagramas
unifilares também no QGIS. A simbologia foi salva em formato “.qml”, que ¢ analogo

ao formato “./yr” do ArcGIS.
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https://pubs.usgs.gov/pp/1395/report.pdf

Sido adicionado o shapefile de estagdes, clica-se com o botdo direito no layer e

seleciona-se “Properties”.
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Depois, em “Style”, clica-se em “Load Style” e deve-se localizar o aquivo “.qml”.

Localizando-lo, abre-se esse e, clica-se entdo em OK. Essa simbologia pode ser um

tanto pesada, e por isso demorar bastante para carregar. Depois de carregada, deve

parecer semelhante a imagem abaixo:
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Nessa simbologia, quando aparecer um ponto rosa, deve-se identificar esse ponto

e entender o porque ele ndo foi lido pela simbologia. Pontos rosa sdo estacdes que ndo
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http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar

medem nem chuva, nem nivel de d4gua, ou apresentam alguma categoria

incompreendida pelo codigo de simbologia desenvolvido pelos autores desse tutorial.

As estacdes em questdo sao da Sub Bacia 85. A estagdo 03052015, de nome
Encruzilhada do Sul — Ipagro, que esta representada de rosa estd marcada como
desativada, ¢ nao possui de inicio e fim de série historica, como todas estacdes
desativadas normalmente apresentam. Sendo assim, ndo ¢ possivel definir qual o tipo

dessa estacdo, e por isso ela ¢ um ponto rosa no mapa, o qual pode ser excluido.
Semelhantemente, faz-se o mesmo para os dados da ANEEL.
Os arquivos “.qml” estdo nos seguinte sitios abaixo:
Simbologia para Estacdes: sitio. Simbologia para PCH: sitio.
Simbologia para UHE: sitio. Simbologia para CGH: sitio.

Para a simbologia funcionar, ¢ necessario que o QGIS esteja lendo as camadas no
mesmo cdodigo que foram escritas. Camadas do Governo Federal costumam estar
sempre escrita em codigo UTF-8. Pode-se checar o codigo que o QGIS estd
considerando para determinada camada simplesmente por acessar as propriedades,

clicar em “General” e depois arrumar “Data source encoding” para UTF-8.

3. Diagrama

3.1 Visualizacao no SIG

Primeiramente, deve-se ativar no ArcGIS/QGIS as camadas:

- UHE

- PCH

- CGH

— Estacdes Hidrométricas
— Rio Principal

— Linha de Drenagem

— Municipios

— Camada da Sub-bacia

Para continuacdo do trabalho e eventuais atualizacdes, sugere-se salvar um

arquivo .mxd, com o nome “DigramaUnifilarSBXX”. Consoante figuras abaixo, pode-
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https://drive.google.com/open?id=0B08viPHIwmy2V3drUzdrU2JySGM
https://drive.google.com/open?id=0B08viPHIwmy2dUhRcjN4MDV0ZTA
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https://drive.google.com/open?id=0B08viPHIwmy2OFdneGxTdndqWGc

se ter uma noc¢do da quantidade de informacao que devera ser colocada no diagrama e
quais possiveis divisdes serdo feitas. A primeira figura apresenta a visualizagdo no

ArcMap, a segunda, no QGIS.
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http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar

3.2 Estimar a area de drenagem das esta¢des fluviométricas, UHE,

PCH e CGH via SRTM30

Lembrando que as estagdes fluviométricas da ANA e as PCH, UHE e CGH da
ANEEL devem estar todas sobre trechos de rio, comega-se no ArcMap a definir os
“Batch Point”, utilizando o ArcHydro (2.1.5). A principio os “BatchPoint” devem ser
colocados no trecho de rio mais proximo dos pontos do inventario, e isso pode ser

verificado utilizando a ferramenta “Medida” do ArcGIS, representada por este

’ + . ’ . 7
simbolo:| uw | Este procedimento ¢ bastante simples, porém vale lembrar que os nomes

dados aos “BatchPoint” devem ser coerentes e representativos em relagdo a estacdo que

correspondem.

Para evitar retrabalho, também auxilia muito observar a area de drenagem que a
ANA ou ANEEL disponibilizam para as estagdes que estao sendo representadas pelos
“BatchPoint”, pois estas podem indicar qual trecho de rio tem maior probabilidade de

a+

ser o correto local da estagdo. Utilizado |ww |, € valendo-se de um pouco de foto

interpretagdo, pode-se medir uma “provavel area de drenagem” da estacdo sobre o

MDE.
Prossegue-se depois com os passos 11 e 12 de 2.1.5 para estimar as areas.

No QGIS, utilizando os processos descritos em 2.2.5, gera-se a camada de area de
drenagem, em seguida se adiciona a projecdo a ser utilizada, descrito em 2.2.7. Entdo,

clica-se em “Vector”, “Geometry Tools” e “Export/Add geometry columns”.

Uma janela abrira. Nela se seleciona qual a feicdo, ou camada (/ayer), cuja area
serd calculada. Também se define qual sistema de projecao serd utilizado. Aqui se usa
“Project CRS”, que, no caso, ¢ nada menos do que a projecao criada. Uma nova feigao
sera gerada, e nessa estardo os dados de area. Essa, porém, ndo sera salva a menos que o

usuario clique nas reticéncias ao lado de “Create temporary layer”, e clique em “Save


http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar

to file”, definindo em sequéncia um local onde salvar essa fei¢do a ser criada. Clica-se

em “Run’”.

Com o processo acabado, abre-se a tabela de atributos (Open Attribute Table) da

feicao gerada.

Podem-se notar duas novas colunas, as quais estdo respectivamente em metros
quadrados (Area) e metros (Perimetro). Aqui se utilizou a camada da bacia 85 como

exemplo.

,/ Added geom info = Features total: 2, filtered: 2, selected: 0 [ (S

= I =
FIEEIE ETER DA FIE \

D Id grid_code Shape_Leng Shape_Le_1 Shape_Area Area_km area perimeter
1 1 1 0 0.00314 0.00314 0.00000 0.00516 5162.32541 328.55165

2 2 2 a 14.74716 14.74503 3.93017 42170.54558 4217054641143 152493731295

Ha um impasse, porém: impossibilidade de calcular a 4rea de drenagem para
varios pontos de uma s6 vez. Ha a opcao de se utilizar o “Batch Process” no algoritimo
de “r.water.outlet”, porém ¢ necessario saber de antemao todas coordenadas (x,y) dos
postos ja corrigidos para cima da linha de drenagem, e digitd-las uma a uma. Pode-se

anotar uma a uma num documento de texto para auxiliar no processo, por exemplo.


http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
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http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar

3.3 Montagem no Microsoft Word

O rio principal ¢ representado no Diagrama Unifilar com uma linha azul (RGB:
0,0,255) de espessura igual a 1pt. Seus afluentes, de mesma cor, apresentam espessura
de 0,75pt. Os afluentes destes corpos d’agua também sdo representados com a mesma
cor, mas com espessura de 0,5pt. Caso existam ainda outros afluentes nestes corpos
d’agua, a espessura ndo deve diminuir; continua com mesma cor e espessura igual a
0,5pt. Os corpos d’agua devem ser identificados com seu respectivo nome e diregcdo de
fluxo, representada por uma flecha também. Os nomes podem ser encontrados no

shapefile de hidrografia da ANA.

E interessante utilizar o Hidro para classificar as estacdes, ja que este software
apresenta as informagdes de forma mais simplificada. A legenda sera explicada com

base no layout do Hidro.

Durante a constru¢cdo do diagrama, ¢ aconselhavel j& colocar caixas de texto com
o tamanho e cor de letra corretos para mais adiante acrescentar os valores de distdncia
entre estagdes, entre nascente e afluente(s), entre afluentes, entre barramentos, etc. Estes
valores serdo calculados em uma etapa posterior ¢ o processo de preenchimento fica

mais simples quando j& existem no diagrama os espacos necessarios.

Durante a primeira parte da construcdo do diagrama ainda ndo se tem os valores
de area de drenagem do SRTM30, mas convém deixar indicado dentro do simbolo das

estagdes um espago para acrescentar esta informagao.

244
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Com esta configuracdo e com estes dados, as unicas informagdes faltantes serao
as distancias entre os elementos e as areas de drenagem das estagdes fluviométricas e

barramentos.

Um ponto importante que se deve observar sdo os rotulos, labels. Esses podem
auxiliar bastante para a montagem do diagrama. Pode-se configurar para que
informagdes aparecam na propria tela de visualizagdo, poupando assim a necessidade de
abrir a tabela de atributos incessantemente para checar informagdes. Para tal, abrem-se

as propriedades da camada, clica-se na aba Rotulos e depois em “Expressdo...”

Propriedades da Carmada @
Ligar & Relacionar I Tempa I Popup HTML |
Geral I Fonte I Selecdo I Exibir I Simbologia Campos I Consulta de Definigio | Rétulos
Rotular feigfies nesta camada
Método: [Rntular as feighes do mesmo modo. ']
Todas as feigies serdo rotuladas utiizando as opgies especificadas.
Sequéncia de Texto
Simbolo do Texto
@] Avial * 18 -
AaBbYyZz
[ ERIra
Outras Opgoes Estilo de Rétulo Pré-definido
Propriedades de Posicionamento... ] [ Faixa de Escala... ] [ Estilos do Rétulo... ]
[ OK ] [ Cancelar ] Aplicar

Escreve-se entdo a expressao desejada para que os campos que se quer visualizar
aparecam no mapa. Entre cada campo usa-se a expressao “ & vbnewline &” para

iniciar nova linha.
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Expressdo do Rétulo @

Expressdo

Campos

Clique duas vezes para adicionar um campo na expressdo Mostrar Tipo =

Historico -
MNumImagens
Datalns
DataAlt
RespAlt

z

[ Anexar ] [ Mostrar Valores... ] Visualizar a descrico do valor do cddigo

Expressdo

Escreva a expressdo no idioma da andlise selecionada. [] Avancado

[Codigo] & vbrewline & [Mome] & vbnewline & [2] | -

] b

[ Verificar H Redefinir ] [ Ajuda ][Carregar... H Salvar...

Andlise: [VBScript - ]

Exemplificando-se: para as estagdes da ANA (pluviométricas e fluviométricas) a
expressdao que exibe o codigo, o nome, a altitude do proprio inventario, e a altitude

estimada via SRTM30 da estacdo € a seguinte:
[Codigo] & vbnewline & [Nome] & vbnewline & [Altitude] & vbnewline & [Z]

Quanto as PCH, UHE e CGH, a expressdo que exibe o nome da AHE, a area de

drenagem, a altura estimada via SRTM30, e o estagio em que ela se encontra ¢:
[NOME] & vbnewline & [AREA_DREN] & vbnewline & [Z] & vbnewline & [ESTAGIO]]

No QGIS, para exibir rétulos, labels, semelhante processo ¢ seguido. Abaixo

segue sequéncia de imagens.

7 ass
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Clica-se no simbolo Epsilon ( [E]).

Ainda na imagem acima também se pode alterar outras configuracdes da legenda
como a disposi¢ao dela (Placement), o formato do texto (Formatting), o estilo e

tamanho do texto (7ex?) e outros.

Em seguida, seleciona-se entdo os campos que se pretende exibir na desejada
ordem, sendo espacados pelo comando “|| "\n' ||”. Em suma, o processo ¢ praticamente
0 mesmo, mas a linguagem utilizada pelo QGIS ¢ um pouco diferente. Auxilia bastante
expandir em “Fields and Values” (1), realizar duplo-clique no campo desejado (2), e
utilizar (3) e (4) para adicionar o “|| "n' ||”. Em (5) se pode ter uma prévia da

expressao que esta se digitando.

3.4 Definicao Legenda Diagrama

3.4.1 Dados da ANA

A simbologia do diagrama seré explicada com base no formato Hidro, que auxilia

na visualizagdo das informagdes do inventario da ANA. Segue um exemplo do formato:
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{Estacan’| Deswrigho | Histérico | Imagens| L.
Identificacio Data de Inicio
Cédig: 76980000 % Mame: PASS0 DO IBICUI Cadigo adicional: [Tipo: Fluviomética = ]
Localizago
Bacia [codigo/mome]: 7 RIO URUIGLAL D Escala [F): 0341364 |4 05/1366
Sub-bacia [eddiga/name]. 76 RIOS URUGUALIBICUI E OUTROS E] Registradar de nivel [} | ———
Rio [codigo/nome]; 76100000 RIO IBICUI E] Descarga liquida [D): -
Estado (codign/nome): 24 RID GR&MDE DO SUL E] Sedimantos [5): 4
Municipio [codigo/nome): 24224000 URUIGLIAIANS, (] Qudlidade da dgua (@) | ———
Entidades Plureidmetra [P): A
Responsavel (codigo/UF Auisdiciosigla);, 00001 27 M ANA g Fiegistrador de chuva [Prl: || —'——
Dperadora (cédign/LIF/rateina Asigla): 000 ANA g Evaporimétrica [E]: i
Coardenadas Climatalégica [C): —
Latitude [GG:MM:55) 232400 Altitude (m): 50,00 Fiezometria 2] i
Longitude (+GGG:MM:55] 056:41:00  Area de drenagem [km2); 47100.00 Telemética (T): i
Rede Atualizagio
Basica: Curso d'agua: Sedimentas: [ltirna atualizagao: 07/06/1934
Energética: E stratégica: Hualidade da agua:
Navega;éo: Captagdo: Classe de vazdo:  |Yazdo obgervada - Data de Fim

Optou-se por dar preferéncia as coletas de dados ativas, que sdo representadas no

Hidro pelo preenchimento das caixinhas com este simbolo: . Quando a caixinha
estiver preenchida, havera somente a data de inicio de coleta do dado. Sempre que

houver uma data de fim, significa que este tipo de medicao foi desativado.

3.4.1.1 Estagoes Fluviométricas

[Tipa:[ Fluviomética | ]

1) Forma
a. EstacOes fluviométricas que apresentarem data de inicio no campo “Descarga
Liquida (D)” sao classificadas como “Estagdo Fluviométrica com Medi¢cdo de

Descarga (FD)” e sdo representadas por um tridngulo:

Estimado via

7 SRTM30

b. Estacoes fluviométricas que ndo apresentarem data de inicio no campo “Descarga

Extraido do <
inventario ANA

Liquida (D)”, mas somente no campo “Escala (F)”, sdo consideradas “Estacdo

Fluviométrica Linimétrica (F)” e sdo representadas por um retangulo:
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Cadigo
Nome

Extraido do < Area
. i Area
inventario ANA Altitude

Altitude

2) Contorno — linha

Estimado via

7 SRTM30

a. Caso alguma das opg¢des de medigcdo em “Coleta/Periodo” apresente o simbolo ],

a estacdo deve estar ativa. Sendo assim, ao menos uma das caracteristicas da

estacdo tera apenas data de inicio. Estagdes ativas tem como traco do contorno

uma linha continua, de preferéncia com espessura 0,75pt:

b. Caso nenhuma das opgdes de medigdo tenha o simbolo [ 1], significa que a estagdo

estd inativa. Sendo assim todos os campos que apresentam data de inicio, terdo

também data de fim. Estacdes inativas sdao representadas com tragco pontilhado no

contorno, de preferéncia com espessura de 0,75pt:

3) Telemetria:

Quando uma estacdo ativa for telemétrica (apresentando apenas data de

inicio e o simbolo []]) ou quando uma estagio inativa foi telemétrica (todas as

medi¢des da estacdo, inclusive a telemetria, t€m data de fim ¢ nenhuma tem o

simbolo[ ] ) acrescenta-se um T no canto direito superior do simbolo, com a

mesma cor do contorno, como mostrado abaixo:

VT Codigo /T
\ Nome ,
\\ Area /
\ Area //
Y Altitude
*Altitude ,/
\ s
\ ’

\ ’
\/
‘

4) Registrador de nivel:

Cddigo
Nome
Area
Area
Altitude
Altitude

Cadigo
Nome
Area
Area
Altitude
Altitude

Se uma estagdo ativa possuir Registrador de Nivel (Fr) (tem o simbold|e

apenas data de inicio) ou se uma estacdo inativa apresentar Fr (todas as

medicoes da estagdo, inclusive o Registrador de Nivel, tém data de fim e

nenhuma tem o simbolo[[]]) acrescenta-se uma linha diagonal por tras do

simbolo, com a mesma cor do contorno, como mostrado abaixo:

Cadigo
Nome
Area
Area
Altitude
Altitude

Codigo
Nome
Area
Area
Altitude
Altitude
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a.

5) Contorno — cor
Quando a entidade operadora da estagdo for a CPRM, como o exemplo acima, o
contorno do simbolo ¢ colocado na cor preta. O codigo de operadora da CPRM ¢

00082.

Entidades
Responsével [codigosUF furisdic3ossigla); 00001 2701 ANA LI
Operadora [codigo/UF Aroteira/sigla): noosz 24 03 CPRM l:l

Quando a operadora da estacao for qualquer outra entidade (codigo diferente de
00082) como em exemplo mostrado acima, o contorno do simbolo sera da cor

vermelha.

Entidades
Responsavel [codigo/UF Aurisdicdozigla), 0000 2F M ANA

B0

Operadaora [cddigo/UF froteirasigla): a0aom Ak,

3.4.1.2 Estagoes Pluviométricas

[Tipu:u:| Fluviométrica - | J

1) Ativas e Inativas
a. Estagdes pluviométricas ativas (com ao menos uma das medi¢des
marcadas com o simbolo [ |]) sdo representadas por circulo totalmente

preenchido da mesma cor do contorno:

Cadigo
Altitude ANA
Altitude SRTM30

b. Estacdes pluviométricas inativas (sem medigdes marcadas com o
simbolo[ |]) sdo representadas por um circulo com preenchimento branco

e contorno com trago de ponto quadrado:

-»
a8
LR 4
Cadigo
Altitude ANA
Altitude SRTM30

2) Registrador de Nivel
a. Estacdes pluviométricas ativas com Registrador de Chuva (Pr) também
ativo recebem uma linha diagonal:
Cadigo

Altitude ANA
Altitude SRTM30

11
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b. Estagdes pluviométricas inativas com Registrador de Chuva (Pr),

apresentando data de inicio e fim, recebem uma linha diagonal:

K .{

L "% 4
Codigo
Altitude ANA
Altitude SRTM30

3) Telemetria
a. Quando uma estagdo pluviométrica ativa for telemétrica, acrescenta-se

um T a direita superior do circulo:
()

b. Se uma estacdo pluviométrica ativa foi telemétrica, acrescenta-se

também um T a direita do circulo:

4) Entidade operadora
a. Quando a entidade operadora for a CPRM, a estacdo pluviométrica ¢

representada na cor preta.

LN
LN
LAY

b. Quando a entidade operadora ndo for a CPRM, a estacao pluviométrica ¢

representada na cor vermelha.
\EJ
| .
o

3.4.1.3 Sistema de Acompanhamento de Reservatorios (SAR)

O Sistema de Acompanhamento de Reservatérios (SAR) da ANA compreende os

reservatorios destinados a diferentes usos, incluindo a gera¢do de energia. Contudo, nos

diagramas unifilares construidos serdo plotados com a simbologia abaixo apenas os

reservatorios que nao forem de uso do sistema elétrico (ANEEL/SIGEL). Esses

reservatorios sao representados no diagrama por um losango com a base menor aberta,

cujo posicionamento depende da dire¢do de fluxo do rio.

12



—> —
—1 '\
- L—
) SAR Nome ) SAR Nome
Area de drenagem SRTM30/ Area de drenagem SRTM30/
Altitude SRTM30 Altitude SRTM30

3.4.2 Dados SIGEL

A informag¢ao mais importante para a simbologia dos dados do SIGEL ¢ o estagio
em que os empreendimentos se encontram. E com base nestes estagios que a simbologia

¢ definida.

Abaixo estdo os estagios de AHE, Aproveitamentos Hidro Elétricos, (CGH, PCH,
UHE) na ordem da implantacdo, constru¢cdo e operacdo, considerando que ndo haja

impasses durante o processo:

1.Eixo Inventariado 6.PB Aceito 11.Construcdo com Outorga
2.EVTE em Elaboracao 7.PB Aprovado 12.0peragdo

3.EVTE Aceito 8.DRI 13.Revogado

4.EVTE Aprovado 9.DRS 14.Desativado

5.PB em Elaboragédo 10.Construgdo ndo iniciada 15.Extinta

Os estagios estdo foram atualizados no dia 21 de Novembro de 2017 no tutorial

quando a mudanca foi notada pela equipe.

3.4.2.1 PCH

PCH (Pequena Central Hidrelétrica) sdo usinas hidrelétricas de pequeno porte,
cuja capacidade instalada encontra-se entre IMW (um megawatt) e 30MW (trinta
megawatts) e cuja area de reservatorio nao ultrapassa 3 km? (300 ha), ou assim definidas
pela ANEEL, conforme Resolucdo n° 652 de 09 de dezembro de 2003.

No Diagrama Unifilar elas s3o representadas por um tridngulo cujo
posicionamento depende da dire¢do do rio. As cores e contornos dependem do estagio

das PCH.

a. Quando a PCH estiver entre os estagios 1 e 8, considera-se em “PCH em estudo

para implantacdo” e representa-se assim:
> PCH Nome

= Area Drenagem ANA /SRTM30 / Altitude SRTM30
b. Quando a PCH estiver no estagio 9 ou 10, considera-se em “PCH com outorga
para implantacdo” e representa-se assim:

—> = : PCH Nome

‘_ Area Drenagem ANA /SRTM30 / Altitude SRTM30

v
ey
.
-
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¢. Quando uma PCH estiver entre os estagios 11 e 12, classifica-se como “PCH em
Operagao ou Construcao — Reservatorio Menor ou Igual a 3km?” e representa-se

assim. PCH Nome

Area Drenagem ANA /SRTM30 / Altitude SRTM30

\

d. Considera-se o estagio 13 (revogado) um retorno a etapa de estudo e, portanto,
segue-se a mesma classificagdo do item a.
e. Ainda ha o estdgio 14 que indica o estado desativado ou extinta. Esse, porém, ¢é

bastante raro e representa-se assim:

) PCH Nome
Area Drenagem ANA /SRTM30 / Altitude SRTM30

\

3.4.2.2 CGH

CGH (Central Geradora Hidrelétrica) sdo unidades geradoras de energia com
potencial hidraulico igual ou inferior a 1 MW (um megawatt), normalmente com
barragem somente de desvio, em rio com acidente natural que impede a subida de

peixes.

No diagrama sdo representadas somente as CGH em fase de construgdo ou
operacdo, na forma de um tridngulo diferenciado que também terd posi¢do definida pela

direcdo do rio. Logo, a classificagdo ¢ a seguinte:

a. Quando a CGH estiver entre os estagios 11 e 12, classifica-se como “CGH em

Operacao ou Construgdo sem reservatorio” e representa-se assim:

’ CGH Nome
Area de drenagem ANA / SRTM30
Altitude SRTM30

h—

3.4.2.3 UHE

UHE (Usina Hidrelétrica de Energia) sdao usinas hidrelétrica cuja capacidade
instalada seja superior a 30MW (trinta megawatts), que possuam reservatorio maior que

3 km? (300 ha) ou assim definidas pela ANEEL.

No diagrama, as UHE sdo representadas por um losango e seguem a mesma

classificacao das PCH:
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Quando a UHE estiver entre os estagios 1 e 8, considera-se “UHE em estudo

para implantagdo” e representa-se assim:
> UHE Nome

Area Drenagem ANA /SRTM30 / Altitude SRTM30

Quando a UHE estiver no estagio 9 ou 10, considera-se “UHE com outorga

para implantagcdo” e representa-se assim:

> :--". UHE Nome

E Area Drenagem ANA /SRTM30 / Altitude SRTM30

vy

Quando uma UHE estiver entre os estagios 11 e 12, classifica-se como “UHE

em Operacdo ou Construgdo — Reservatorio Menor ou Igual a 3 km®’ e

representa-se assim:

) UHE Nome
Area Drenagem ANA /SRTM30 / Altitude SRTM30

d. Considera-se o estagio 13 (revogado) um retorno a etapa de estudo

portanto, segue-se a mesma classificacdo do item a.

e,

e. Ainda ha o estagio 14 que indica o estado desativado ou extinta. Este, porém

¢ bastante raro e ¢é representado assim:

> ) UHE Nome
Area Drenagem ANA /SRTM30 / Altitude SRTM30

3.4.2.4 Quadro Resumo

Abaixo segue quadro resumo das simbologias utilizadas para AHE.

Estagios UHE | PCH | CGH*

e Construgdo com outorga
e Operagao
e Revogado

AHE em Operagao
ou Construcao

AHE com Outorga | e DRS-PCH
para Implantagdo | e Construgdo ndo iniciada .

e Eixo Disponivel
e VB com Registro, com Aceite, ou

AHE em Estudo VB Aprovado
para Implantacdo | e PB com Registro, com Aceite, ou
PB Aprovado
e DRI-PCH

AHE Desativada ou Extinta ' < k

*Escolheu-se apresentar apenas as CGH em Operagdo ou Construgédo por se tratar de uma AHE deveras
pequena.
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3.5 Verificacdo dos dados

Com o diagrama esquematizado, ¢ a area de drenagem das estacdes
fluviométricas, UHE, PCH e CGH ja geradas, parte-se para verificagdo dos dados. Essa
¢ feita através da comparacao dos valores de altitude e area de drenagem informados

nos inventarios e aqueles obtidos com base no MDE SRTM30.

No ArcGIS, os dados obtidos devem ser primeiramente exportados para planilhas
de excel. Exporta-se estes shapefiles, abrindo a “Tabela de Atributos”, selecionando
em 2 = (Opgdes da Tabela) o icone “Exportar...”. Salvar como arquivo de texto e

abri-lo no excel.

No QGIS, pode-se gerar a area de drenagem de cada ponto, culminando em “n”
arquivos raster, os quais posteriormente sdo todos transformados em camadas, e podem
por fim, entdo, ser unidas numa Unica camada. Por fim, pode-se clicar com o botao
direito nessa camada-unido e salva-la, Save as, como arquivo formato excel, “MS Office

Open XML spreadsheet [XLSX]”.

Todos os pontos que apresentarem diferencas significativas de area de drenagem
devem ser verificados no ArcGIS. Deve-se fazer uma andlise a respeito das diferencas
encontradas com base nas possibilidades de posicionamento dos pontos. Caso for
encontrada, nesta etapa, um local mais adequado para a marcac¢do do “BatchPoint”, ou,
no QGIS, “Outlet point”, este procedimento deve ser refeito e os dados devem ser
substituidos. Todos os “BatchPoint” que ficarem muito distantes dos pontos cadastrados
nos inventdrios devem ser informados a entidade responséavel pela divulgag¢do dos

dados. Aqueles que gerarem davidas sobre a sua posi¢do também serdo informados.

Algumas duvidas também podem e devem ser esclarecidas com o uso do Google
Earth. Segue abaixo exemplo da diferenca entre a representagdo no ArcGIS e no Google
Earth da posi¢do da estagdo 76500000 — Jacaqua. Na figura abaixo, verifica-se um erro
na geracdo da drenagem pelo MDE SRTM30, constatado apenas pela verificagdo das
imagens de satélite do Google Earth. A estacdo esta rio principal, em vez de estar no

afluente sinuoso.
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3.6 Distancias

Apods a verificagdo, analise e possivel modificagdo do posicionamento das

estagoes fluviométricas, UHE, PCH e CGH, pode-se entdo calcular as distancias.

Todos os rios representados no Diagrama Unifilar devem ser isolados e a
ferramenta “Dissolver” deve ser utilizada para que cada rio seja representado somente
por um trecho. Esta ferramenta se encontra em “ArcToolbox” > “Ferramentas de

Gerenciamento de Dados” > “Generalizacdo” > “Dissolver”.

Cada rio entdo sera dividido nos pontos onde existir algum aspecto de interesse:
estagdes fluviométricas, UHE, PCH, CGH, afluentes, etc. Esta divisdo ¢ feita por meio

da Barra de Ferramentas “Editor” e a ferramenta “Dividir” (= ).

2

— Com o rio dividido em trechos, abre-se a “Tabela de Atributos”.

— Em “Opgoes de Tabela” selecionar “Adicionar Campo...”.

— Nomear o campo “Distancia” e definir como tipo “Duplo”.

— Antes de seguir para os proximos passos, deve-se garantir que o sistema de
coordenadas da estrutura de dados seja o Lambert e que as coordenadas
sejam referenciadas ao Datum SIRGAS2000.

— Clicar com o botdo direito do mouse sobre o cabecalho da nova coluna na
Tabela de Atributos e selecionar “Calcular Geometria...”.

— A seguinte caixa de didlogo serd aberta:
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¥ |
Calcular Geometria &J

Propriedade: Comprimento - ]

Sistema de Coordenadas

~I Utilizar sistema de coordenadas da fonte de dados:

PCS: South America Lambert Conformal Conic

@ Utilizar sistema de coordenadas da estrutura de dados:
PCS: South America Lambert Conformal Conic

Unidades: Quildmetros [lm] v]

Calcular somente registros seledonados

Sobre calcular geometria [ oK ][ Cancelar ]

%

— Definir a propriedade “Comprimento”, selecionar o sistema de coordenadas
da estrutura de dados e utilizar como unidade “Quilometros [km]”.

— Apos este procedimento, na coluna “Distancia” estara o comprimento de
cada um dos trechos que foram divididos. Estes dados podem ser entdo

acrescentados no Diagrama Unifilar.

Este procedimento serd repetido para cada um dos rios representados no diagrama

unifilar.

Para facilitar a visualizacdo e montagem do diagrama, aconselha-se utilizar o

rotulo da distancia para agilizar a montagem.

i PETE TR S e

311,949284 361,774335

73201000 =
UHE ITA JUSANTE
311,949284

UHE ITA RESERVATORIO 1

S
<
&
S
&

73200500 &
RIO PALOMA

279,225618
@
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No QGIS, o processo ¢ semelhante. Usando-se o vetor de drenagem derivado do
raster de Stream segments, obtido no item 2.2.6, basta realizar processos de “Advanced

Digitizing” (Figura abaixo). Deve-se tornar a camada editavel, clicando em Toggle

. . a» . .
Editing E] Usa-se as ferramentas de corte de feigdes ¢® , Split Features, unido de

feicdes (%D Merge Selected Features, selecao de feigdes ==+l Select Features by area

or single click, e deselecionar &, Deselect Features from All Layers. Quando se

pretende cortar duas vezes o mesmo segmento, ¢ necessario cortar uma vez, salvar a

edi¢do, e abrir novamente o modo de edi¢do. Para tal, basta clicar em V. “Save for

Selected Layers(s)”.

Salienta-se aqui ainda que para calcular as distancias no QGIS, deve-se utilizar a
devida projecdo de maneira descrita nos e 2.1.7, para o ArcGIS, e 2.2.7, para o QGIS.
Depois usando “Export/Add geometry columns”, extrai-se o valor de distancia da

camada como descrito no item 3.2.

3.7 Areas de Drenagem

Uma das informagdes de relevancia que pode ser extraida de um Diagrama
Unifilar ¢ a definicdo dos pontos para os quais a precipitacio medida nas estagdes
pluviométricas vai drenar. Em consequéncia disso, também se define quais dados de
vazdo sao influenciados por estes dados de precipitacdo. Estas informacdes devem ficar
bastante claras quando se analisa um diagrama Unifilar. Por isso, em dareas onde
surgirem duvidas a respeito destas informagdes, deve-se verificar a situagdo no ArcGIS

e esclarecer no diagrama.

O exemplo abaixo mostra uma situa¢do no ArcGIS e como ela foi representada no

diagrama. O ponto laranja representa a estagcdo fluviométrica 76290000 — Passo dos
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Farrapos enquanto o ponto verde representa a estacao pluviométrica 3055005 — Santa

Rita.

®

%ﬁ% )
=
P ﬂ%

. 76290000 .T
3055005 Passo dos
200m Farrapos

178m 4133km? | 105m
105m

x>
I

4. Consisténcia de dados inventariais para construcio do Diagrama

Unifilar

Os dados inventariais de estacdes da ANA e/ou UHE, PCH ¢ CGH da ANEEL
deverdo ser consistidos (verificados) para serem, com seguranga, colocados no diagrama
unifilar a ser construido. A localizagdao geografica das estagdes fluviométricas,
pluviométricas e dos barramentos deve ser via SIG confrontada com camada de bacias
hidrograficas, area territorial dos municipios, etc., para conferéncia com os dados
registrados. Incongruéncias nestes dados sdo indicativos que podem apontar para algum

equivoco de localizagdo (coordenadas) do item a ser representado no diagrama unifilar.

A delimitagdo automética do perimetro e o consecutivo calculo da area de
drenagem de estacdes fluviométricas, utilizando algum MDE, para posterior conferéncia
com os dados disponibilizados no inventdrio da ANA e/ou ANEEL, fornece um bom
indicativo que a localizagdao geografica (coordenadas) da estacdo e/ou empreendimento
hidrelétrico pode estar errada. Para tanto, sugere-se adotar como hipotese de equivoco

da coordenada geografica quando uma diferenga igual ou maior de 1% entre a area
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obtida pelo MDE e a que consta nos inventarios (estacao F ou FD,ou CGH ou PCH ou
UHE) apresentar-se. Deve-se entdo entrar em contato com a ANA e/ou ANEEL para
solicitar uma verificagio dos dados disponibilizados de tais estagdes no inventario. E

importante enunciar no e-mail a data do inventario em questao.

O mesmo procedimento de verificacdo de area de drenagem também pode ser
feito para altitude de estagdes fluviométricas ou pluviométricas. Extraindo a altitude do
MDE para cada estagdo, compara-se com os dados de inventario, levando a um
indicativo de equivoco na localizagdo geografica estagao. Com relagdo a altitude,
sugere-se que o analista adote como hipotese de equivoco nos dados fornecidos quando
a diferenca entre a altitude no inventario e a altitude segundo o raster do SRTM30 for

maior que 30m de diferenga. Semelhantemente, nesse caso, deve-se contatar a ANA.

Uma maneira pratica de realizar essa verificacdo da altitude, que ¢ um indicativo
de posicionamento geografico equivocado da estagdo, € por exportar a camada referente
as estacdes pluviométricas e fluviométricas para o Excel apods adicionar os dados de
cota do STRM30 ja mencionados no item 2.1.4/2.2.4. Apos isso, deve-se deletar as
colunas indesejadas no excel e criar uma nova coluna para calcular o modulo da
diferenca de altitude medida em campo com a extraida pelo SRTM 30. Por fim, aplica-
se uma formatacdo condicional a fim de modificar o preenchimento das células que
necessitam ser revisadas e encaminhadas para a ANA. Um modelo desse

arquivo de excel pode ser encontrado nesse sitio.

Devem ser averiguadas situagcdes em que a localizacdo de estacdes fluviométricas,
PCH, UHE ou CGH estiver muito distante de cursos d’agua, ou quando houver davidas
quanto a correta localizacao do ponto. Abaixo segue imagem em que hé quatro estacoes
todas com o mesmo nome, mas em locais ligeiramente diferentes. Pode ser que todas
tenham sido instaladas no mesmo local, porém mediu-se a posi¢do de maneira

equivocada; cabe serem conferidas.

76


https://drive.google.com/open?id=0B5VdVLrE05QEZExqdG1XUkotOWc

@ v 12 - [Estagh (2652940 ABELARDOLUZ)
Py
YL |

Gt Bt | ]

e
o 20t Cobo b

05 L AP § T

Guia de turssm

para posteriormente tirar as dividas.

@ M8 12 - Estagho (73600700, UME GUEBAA QUEIKD RSANTE

@ s e 5
D8E A& RS0 & For

e

ot ISP (2] U B LED 50T T ——

o s

s

=5

-,

&
A
2652000
ABELARDO LUZ
740237132
v
e
73600000
ABELARDO LUZ
© 742891195

2652070
ABELARDO LUZ_Centro

2652043

ABELARDO LUZ 762973111
781290234 7

v

unha | Camiono [ Pro

Mega & distincia entre dois pontos no chile

1.030,48 [Metros

1033,13
170,66 graus

Caso algum dos dados esteja ausente no hidro da ANA deve-se marcar a estacao

Y 73600700
UHE QUEBRA QUEIXO JUSANTE,

477919917 L

S0 Dormingas
73600800

AHQQ JUSANTE

~ 436,740268

e —

77


http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar
http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar

Por fim pode-se também confrontar os dados com o arquivo shapefile (.shp) dos

municipios do IBGE: se a cidade ndo for a mesma, ¢ sinal que pode haver algum erro.

- Ol

—

| . 73730000 2652005
PORTO ELVINOPORTO ELVING
489012629 _ 489,012629

rrrrr

3720080
FOZ CHAPECOZINHO
= 446 470291

Exemplos de erros verificados

Abaixo segue um exemplo de duvida que surgiu durante a construgdo de um
diagrama unifilar. O inventario da ANA de 10 de julho de 2015 colocava a estagdo
76600000 — Passo do Itaum entre dois meandros do rio Ibicui. Foi enviado um pedido
pelo site de Acesso a Informagdo e a ANA respondeu informando coordenadas mais
precisas para a estagdo. As novas coordenadas colocavam a estacdo no ponto verde,
representado abaixo, nao deixando duvidas quanto o meandro ao qual a estacdo

realmente pertence.

TEE00000
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Todas as estacdes F a jusante em um curso d’agua devem possuir cota menor e
area de drenagem maior em relagdo as de montante. Caso isso ndo esteja de acordo na
constru¢do do diagrama, hé inconsisténcia. A seguir disponibiliza-se um modelo e
exemplos de verificacdo dos dados de coordenadas geograficas das estagdes junto a ANA.
O mesmo deve ser realizado para os barramentos (UHE, PCH e CGH) e caso haja
inconsisténcias elas devem ser encaminhadas para ANEEL. Um exemplo disso é

disponibilizado junto com os outros sitios abaixo.

Sitio para acessar o modelo de verificacdo das coordenadas geograficas das estacdes
pluviométricas e fluviométricas:

https://drive.google.com/open?id=0B5VdVLrEO5QEcThLdHItQTYOcXM

Sitio para acessar a verificacdo das coordenadas geograficas das sub-bacias 80 a 84:

https://drive.google.com/open?id=0B5VdVLrE0O5QEckxUZzEtZHZDazg (Sub-Bacia 80)

https://drive.google.com/open?id=0B5VdVLrEQO5QEdIUta2cycnN5UkU (Sub-Bacia 81)

https://drive.google.com/open?id=0B5VdVLrEO5QEdmZtcFpPeENOSmMc (Sub-Bacia 82)

https://drive.google.com/open?id=0B5VdVLrEO5QEV2NFNEIxY045aEE (Sub-Bacia 83)

https://drive.google.com/open?id=0B5VdVLrEOSQEOHRKRIM4NDRIYUO  (Sub-Bacia 84)

Sitio para acessar a verificagdo das coordenadas geograficas dos barramentos da

bacia 8: https://drive.google.com/open?id=0B5VdVLrEOSQEb2ZFVGMS5YU9hSmM

4.1 Acesso a informacao do governo federal

Duvidas ou erros verificados ao longo do processo de construcdo do Diagrama
Unifilar devem ser informados a entidade responsavel pela divulgacdo dos dados (no
nosso caso, ANA ou ANEEL). Caso o dado ndo possa ser obtido pela entidade, deve-se
tentar com a entidade responsavel pela estagcdo ou barramento.

Em dltimo caso isto pode ser feito através do portal de Acesso a Informagdo em
http://www.acessoainformacao.gov.br/. Deve-se criar um login e fazer um pedido no site.

A seguir, um modelo de "carta" para se mandar para a ANA pedindo a verificacdo de dados
inventariais:

Titulo: Conferéncia altitude / coordenadas geodésicas de estacBes da sub-bacia xx
Caro(a) responsdvel da ANA,

Pedimos a verificacGo da altitude e coordenadas geodésicas de xx estacbes, em
anexo, da rede hidrometeoroldgica nacional, cujos dados foram disponibilizados no
sistema hidroweb no inventdrio datado de x de xxx de 20xx.

No anexo verificaram que hd diferencas significativas da altitude registrada no
inventdrio de 3 de julho de 2015 em relacGo a extracdo das altitudes pelo MDE de 30 m
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(disponivel em:http.//earthexplorer.usgs.qov/). Este fato nos alerta para um possivel

equivoco de localizagdo geogrdfica destas estagdes.

Estamos construindo um diagrama unifilar das sub-bacias da bacia x visando estudos
hidroldgicos e a correta localiza¢éo geogrdfica dos dados é essencial para ndo produzirmos
informagdes erradas.

Cordialmente,

Se nenhuma dessas medidas surtir efeito, os dados devem ser deixados em branco
no diagrama, mas lembre-se que para uma maior confiabilidade, deixar o dado em branco
é a ultima opcdo. O ideal é ter o maximo de dados possiveis no diagrama com certeza dos
valores.

4.2 Outra abordagem para se consistir os dados

Ha também outra maneira para se consistirem os dados inventarias. Nela nao se
usa o Hidro, apenas o proprio programa de SIG. Porém, para usé-la, faz-se necessario
preparar a tabela Excel. No item 2.1.2/2.2.2 constam os passos para se adicionar uma
coluna nova de municipio aos dados inventarias. A func¢ao dessa coluna ¢é tdo somente
interpretar os cddigos da ANA, e retornar em texto (string) o nome do municipio. Na

consisténcia de dados se costuma consistir os tais cinco itens:

— Altitude

—  Area de Drenagem
— Coadigo

— Municipio

— Nome do Rio

Sendo assim, pode-se criar também uma coluna para nome do rio no excel/ das
estacdes, € em processo semelhante ao item 2.1.2/2.2.2, importar a relacdo de “nome do

TR cC

rio”-“codigo ANA de nome do rio”. Depois, importa-se essa tabela excel para o
programa de SIG, e extrai-se do MDE (SRTM30) a altitude de cada ponto, e, por fim,
adiciona-se o calculo de area de drenagem para cada estagdo. Assim, torna-se capaz
trabalhar apenas com o programa de SIG para fazer a consisténcia de dados. Costuma-se
entdo manipular os rétulos que aparecerdo no programa de SIG. Pode-se definir um
rétulo que apresente: codigo da estagdo, altitude ANA, éarea de drenagem ANA,
altitude SRTM, d4rea de drenagem SRTM, municipio ANA e nome do rio ANA.

Adiciona-se também o rotulo para a camada de municipios e drenagem. Embora essa

abordagem seja mais trabalhosa no inicio, ela facilita bastante para visualizar os dados.
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Como exemplo, apresenta-se em seguida uma consisténcia de municipios. A
primeira parte que consiste em criar coluna de municipio onde o nome esteja em texto

(string) consta no item 1.1.g.

Para checagem de municipios se compara o campo MunicipioNome (criado no
item 2.1.2/2.2.2) do shapefile criado a partir do inventario ANA com a camada de
municipios mais atual que pode ser obtida pelo site do IBGE
(<http://mapas.ibge.gov.br/bases-e-referenciais/bases-cartograficas/malhas-

digitais.html>).

Uma abordagem ¢ adicionar a legenda da camada de estacbes o campo
“MunicipioNome”, ¢ adicionar a legenda da camada de municipios do IBGE o campo
“Nome”. Clica-se em propriedades da camada de estacdes,
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Para a camada de municipios do IBGE, segue-se processo semelhante, porém
digita-se “[NM_MUNICIP]”. Sugere-se que em “Text Symbol”, utilize-se uma fonte

diferente daquela da utilizada para as estagdes.

Por fim, pode-se checar uma por uma conforme o diagrama unifilar ¢ produzido.
Abaixo segue imagem de exemplo. Optou-se por um tamanho maior e em negrito para

os rotulos dos municipios, possibilitando a melhor visualizagao do Usudrio.

Br=re SANTA CRUZ DO SUL
CANDELARIA

RIO PARDO

CACHOEIRA DO SUL

PANTANO GRANDE

ENCRUZILHADA DO SUL
DOM FELICIANG

Deve-se notar que algumas estagdes estdo em divisa de municipios, € ndo se
deve considerar erroneo caso o nome apontado pelo inventario ANA seja do municipio
ligeiramente vizinho. Deve-se atentar ndo por menos quando os municipios nao

possuirem divisa.

Processo semelhante também ¢ sugerido para consistir dados de localizacdo do
inventario da ANEEL (AHE: UHE, PCH, CGH). Nesses a expressao utilizada ¢
“INOME] & vbnewline & [MUNIC 1] & vbnewline & [MUNIC_2]”. O inventario
ANEEL apresenta dois campos de municipios porque os AHE costumam se encontrar

na divisa de municipios.
Exemplo

A seguir mostra-se um exemplo de diagrama Unifilar feito com base nesta
metodologia. A divisdo das sub-bacias apresentada foi baseada na metodologia
desenvolvida por Otto Pfafstetter. O diagrama unifilar apresentado a seguir pode ser

observado em detalhes no trabalho de Koefender (2015).

82


http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar

Diagrama Unifilar da Sub-Bacia 76 — Parte 3 de 4
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http://rigeo.cprm.gov.br/jspui/handle/doc/4/simple-search?location=&query=&filter_field_1=author&filter_type_1=equals&filter_value_1=MARCUZZO%2C+Francisco+Fernando+Noronha&rpp=100&sort_by=dc.date.issued_dt&order=DESC&etal=0&submit_search=Atualizar

5. Modelo padriao e demais materiais para construcio do diagrama

unifilar proposto neste tutorial

No Quadro 1, mostram-se os enderegos (“sitios”) para baixar o modelo padrao

inicial para constru¢do do diagrama unifilar segundo a metodologia e a semiologia

cartografica (legenda) propostas neste tutorial. Este material também pode ser solicitado

pelos emails dos autores (amalia.koe@gmail.com; francisco.marcuzzo@cprm.gov.br; gm

guimaraess(@gmail.com; juliano.finck@gmail.com).

Quadro 1 — Material para baixar da internet para construcao de diagrama unifilar.

Material

Enderecos (“sitios”) Para Baixar o Material Visando a
Construcdo de Diagrama Unifilar de Bacia Hidrografica Para

Estudos Hidroldgicos

Modelo Padrdo Inicial (.docx) Para

Construgdo de Diagrama Unifilar

https://onedrive.live.com/view.aspx?cid=f3e4c2alea2998 1a&page=view&resid=F3E4
C2A1EA29981A1238&parld=F3E4C2A1EA29981A!220&app=Word&wacqt=undefi

ned

Tutorial: CONCEPCAO DE DIAGRAMA
UNIFILAR DE BACIA HIDROGRAFICA
PARA ESTUDOS DE INTERESSE
HIDROLOGICO: O passo a passo de como
obter as informagdes, como montar o
diagrama unifilar e como verificar e corrigir

seus dados inventariais basicos

https://onedrive.live.com/view.aspx?cid=f3edc2alea29981a&page=view&resid=F3E4
C2A1EA29981A1236&parld=F3E4C2A1EA29981A!1220&app=WordPdf&wacqt=und

efined

Tutorial: Como Baixar Imagens SRTM30
(2014), Mosaicar, Calcular Area de
Drenagem, Extrair Altitude, Gerar MDE e
Criar Mapa de Declividade Versdo 2

https://onedrive.live.com/view.aspx?cid=F3E4C2A 1 EA29981A&resid=f3e4c2alea29
981a%21222&app=WordPdf&wdo=1

Ottocodificagdo de Bacias Hidrograficas

https://drive.google.com/file/d/0B6T7sNg_aVgObEhkL WdDZVIXaGM/view?usp=sha
ring
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6. Como referenciar, em referéncias bibliograficas, este tutorial
visando citar a utilizacido do modelo e dos procedimentos aqui

exemplificados

KOEFENDER, A.; SOUZA, C. J. R.; ALMEIDA, D. B; GUIMARAES, G. M.; FINCK,
J. S.; MARCUZZO, F. F. N. A CONCEPCAO DE DIAGRAMA UNIFILAR DE
BACIA HIDROGRAFICA PARA ESTUDOS DE INTERESSE HIDROLOGICO:
O passo a passo de como obter as informacdes, como montar o diagrama unifilar e
como verificar e corrigir seus dados inventariais basicos. 2017. 90p. versao 4.1.
Tutorial. Manual desenvolvido durante estagio no projeto de regionalizacdo de vazdes
na CPRM-PA/GEHITE. Porto Alegre, 2017. Disponivel em:
<https://drive.google.com/file/d/0BSVAVLIEOSQEeGw4MHN3b2V6b2s/view?usp=sha
ring>. Acesso em:...
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